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Notas importantes sobre la manipulación y el uso

• Esta máquina es un dispositivo de precisión.

• Instale la máquina en un lugar que tenga la temperatura y la humedad relativa especificadas. Para ob-
tener más información, véase Especificaciones(P. 348).

• Conecte el adaptador de CA y los cables USB y Ethernet de forma segura.

• Al mover la máquina, apoye siempre la parte inferior con las manos. Si la máquina se mantiene en otro
lugar, puede dañarse al moverla.

Uso Ubicación/Uso Espacio

Instale la máquina en un lugar nivelado y estable.

Nunca instale la máquina en ninguno de los siguientes lugares. De lo contrario, puede provocar una reduc-
ción de la calidad o un mal funcionamiento.

• Lugares sujetos a grandes fluctuaciones de temperatura o humedad

• Lugares sujetos a sacudidas o vibraciones

• Lugares donde el piso está inclinado, no nivelado o inestable

• Lugares polvorientos

• Lugares expuestos a la luz solar directa

• Ubicaciones a menos de 1 m de una fuerte iluminación interior

• Ubicaciones cerca de equipos de aire acondicionado o calefacción

• Lugares expuestos al agua o al aire en movimiento

• Lugares expuestos a ruidos eléctricos o magnéticos considerables u otras formas de energía electro-
magnética

Importante

DGSHAPE Corporation no asume ninguna responsabilidad por cualquier pérdida o daño a los datos resultan-
tes de un mal funcionamiento o daño del ordenador. (Haga siempre una copia de seguridad de los datos
importantes)

Soporte

La información de soporte que se pone a disposición a través del sitio web de DGSHAPE Corporation se ac-
tualiza periódicamente para ofrecer una referencia útil en caso de que se produzcan problemas. Antes de
ponerse en contacto con nosotros, consulte la información del sitio web junto con «Métodos de resolución
de problemas».

Hay que tener en cuenta que las direcciones URL contenidas en este manual están sujetas a cambios sin previo aviso.

IMPORTANTE

 ENLACES RELACIONADOS 

・ https://www.rolanddg.co.jp/
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Unidad principal del equipo de corte

Anterior

N.º Nombre Vista de conjunto funcional

Palanca de carga Utilícelo cuando cargue material.

Rodillo de arrastre izquierdo Levante la palanca de carga y luego arrastre el material con ésta. Co-
lóquelo en el borde izquierdo del material.

Carro de corte Instale el soporte de la cuchilla. Esta parte se mueve a la izquierda y a
la derecha para cortar el material.

Rodillo de arrastre derecho Levante la palanca de carga y luego arrastre el material con ésta. Co-
lóquelo en el borde derecho del material.

Rodillo de presión Este rodillo alimenta el material hacia la parte delantera o trasera.

Patrón de presión Indican la ubicación de los rodillos de presión. Al cargar el material,
asegúrese de colocar los rodillos de arrastre dentro del área indicada
por cada uno de estos patrones.

Protector de la cuchilla Esto protege la punta de la cuchilla durante el corte.

Línea guía Es una guía para alinear el material al cargarlo.

Guía de la cuchilla Introduciendo una cuchilla, etc. y moviéndola a lo largo de la guía, el
material puede ser cortado sin ser descargado.

Nombres de piezas y funciones
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N.º Nombre Vista de conjunto funcional

Panel de operaciones Se utiliza para realizar diversas operaciones.

Nombres de piezas y funciones
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Atrás

N.º Nombre Vista de conjunto funcional

Conector USB Es para conectar un cable USB.

Conector del cable de alimenta-
ción

Es para suministrar energía a la máquina.

Conector Ethernet Es para conectar un cable Ethernet.

Línea guía Es una guía para alinear el material al cargarlo.

Nombres de piezas y funciones
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Panel de operaciones

▲
▲ ▲▲

Parte Nombre Detalles Nota utilizada en es-
te documento

W:261mm
L:----  [0mm]  

Mostrar Esto muestra varios menús de configuración y
otra información.

—

TEST Tecla TEST Manténgalo pulsado durante 1 segundo o más
para cortar un patrón de prueba previamente
guardado.

[TEST]

ORIGIN Tecla ORIGIN Manténgalo durante 1 segundo o más para fijar
la posición actual de la cuchilla como origen.

[ORIGIN]

PAUSE Tecla PAUSE Esto interrumpe la operación. Pulse de nuevo
para reiniciar la operación.

[PAUSE]

▲
▲ ▲▲

Teclas del cursor Utilice estas teclas para mover el carro de cor-
te o el material, o para seleccionar o ajustar
elementos del menú.

[▲] [▼] [◀] [▶]

MENU

Tecla MENU El mensaje de la pantalla cambia cada vez que
se pulsa esta tecla.

• Condición de corte que se establece actual-
mente

• Modo menú
• Visualización de la anchura o del tipo de

material

[MENU]

Nombres de piezas y funciones
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Parte Nombre Detalles Nota utilizada en es-
te documento

FORCE Tecla FORCE Esto muestra el menú de ajuste de la fuerza
de la cuchilla.

[FORCE]

ENTER Tecla ENTER Se utiliza para seleccionar un elemento del
menú y para finalizar un ajuste.

[ENTER]

PEN FORCE

Deslizador PEN FORCE La fuerza de la cuchilla puede ajustarse con
precisión. Incluso puede realizar este ajuste
mientras se está cortando.

[PEN FORCE]

Botón de encendido Al pulsarlo se enciende la alimentación, que se
ilumina en azul. Pulse este botón durante 1 se-
gundo o más para desconectar la alimenta-
ción.

—

 ENLACES RELACIONADOS 

・  P. 22 "CONDICION"

Nombres de piezas y funciones
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Lámpara LED del carro

Los estados de la máquina se indican con los colores de las lámparas LED y sus patrones de iluminación.

Estado de la máquina Estado del LED

Desconexión de la alimentación

Apagado

Conexión de la alimentación

Iluminado en azul

Durante la desconfiguración
(cuando la palanca de carga está bajada)

Repite la iluminación en azul brillante y luego en azul tenue

Durante la configuración
(cuando la palanca de carga está levantada)

Iluminado en azul tenue

Durante el corte

Iluminado en azul

Mientras está en pausa

Parpadeo en azul

Cuando se produce una anomalía en la máquina

Parpadeo en rojo

 ENLACES RELACIONADOS 

・  P. 336 Mensajes de error

Nombres de piezas y funciones
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Tipos de materiales

A continuación se muestran los dos tipos principales de materiales utilizados con esta máquina.

• Material en rollo

Materiales enrollados en un tubo de papel

• Material plano

El material no está enrollado en un tubo de papel, como los materiales de tamaño estándar

Se pueden elegir varios materiales en función de su finalidad. Para obtener información detallada sobre
cada material, póngase en contacto con su proveedor de materiales.

Este manual puede referirse colectivamente a los materiales en rollo y a los materiales planos como «medios» o «mate-
rial».

NOTA

Condiciones de los materiales utilizables

Las condiciones de los materiales que se pueden cargar en la máquina se muestran a continuación.

Tamaño

Anchura 50 a 700 mm

Longitud *1 100 mm o más (material plano)

Espesor del material a cortar *2 0.3 mm o menos (para la carga, hasta 1,0 mm

Peso Peso máximo del material en rollo 5 kg

 

*1 No hay límite para el material en rollo

*2 Incluye el espesor del papel de soporte (papel protector)
 

Materiales que no se pueden utilizar

En esta máquina no se pueden utilizar materiales con alguna de las siguientes características. Desenrolle y
enderece la forma del material antes de cargarlo.

• Muy deformado o doblado

• Los bordes no son paralelos

Para Imprimir y Cortar, no se pueden utilizar los siguientes materiales además de los mencionados ante-
riormente.

• Material transparente

• Material de color

Para la impresión y el corte, utilice material blanco con papel de soporte que pueda imprimirse con una impresora láser
o de chorro de tinta. La detección automática de las marcas de corte puede no ser posible para algunos materiales,
como los laminados o los brillantes.

• Tipos de materiales que se pueden imprimir con impresoras láser
Papel fino
Papel recubierto

NOTA

Material utilizado
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Papel artístico
PET

• Tipos de materiales que se pueden imprimir con impresoras de inyección de tinta
Papel fino
Papel recubierto

Material utilizado
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Marcas de corte

Las marcas de corte se utilizan para la alineación al cortar el material, que se imprime desde su impreso-
ra, en esta máquina. El hecho de que la máquina recuerde las posiciones de las marcas de corte, que se
imprimen junto con la imagen, permite corregir las posiciones de corte.

Marcas de corte legibles

El sensor de la máquina solo es capaz de leer marcas de corte como el círculo que se muestra a continua-
ción.

• Diámetro: 10 mm

• Color: Negro

Es posible que la máquina no pueda leer correctamente las marcas de corte impresas en función de la tinta de impre-
sión utilizada.

NOTA

Cuándo utilizar las marcas de corte [3] vs[4]

Normalmente se utiliza [4]. Como [3] tiene menos marcas de corte que [4], el tiempo necesario para el
corte se reduce. Sin embargo, el Tool Mode no está disponible con [3].

 ENLACES RELACIONADOS 

・  P. 344 Los márgenes y la distancia entre las marcas de corte

Marcas de corte/marcas de herramientas
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Marcas de herramientas

Las marcas de herramientas se utilizan para la alineación manual cuando no es posible realizar una alinea-
ción automática mediante marcas de corte.

Se pueden imprimir alrededor de las marcas de corte utilizando CutStudio o complementos.

 ENLACES RELACIONADOS 

・  P. 179 Imprimir y Cortar en Tool Mode

Marcas de corte/marcas de herramientas

18  Información básica



Operaciones básicas
Operaciones de la fuente de alimentación .........................................................20

Conexión de la alimentación ...................................................................20
Desconexión de la alimentación ...............................................................20

Comprobación del menú de la pantalla .............................................................21
"CONDICION" ......................................................................................22
"SYSTEM INFO." ...................................................................................24
"OTROS" ............................................................................................25

Preparación del material ..............................................................................27
Posición de carga del material .................................................................27
Configuración del material plano..............................................................29
Configuración del material en rollo ...........................................................35

Preparativos para la salida de corte.................................................................41
Paso 1:  Prepare la cuchilla.....................................................................41
Paso 2:  Instale el soporte de la cuchilla .....................................................43
Paso 3:  Realizar corte de prueba .............................................................45
Paso 4:  Ajuste de la posición de inicio de impresión ......................................48

Operaciones básicas 19



Conexión de la alimentación

Procedimiento

1. Pulse el botón de encendido.

La máquina se enciende y el indicador luminoso se ilumina.

Desconexión de la alimentación

Procedimiento

1. Mantenga pulsado el botón de encendido durante un segundo o más.

La alimentación se desconecta.

2. Baje la palanca de carga y retire el material.

Cuando no utilice la máquina, mantenga la palanca de carga bajada aunque esté encendida.

 ENLACES RELACIONADOS 

・  P. 304 No se puede desactivar la alimentación

Operaciones de la fuente de alimentación
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Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse varias veces [▲][▼] para mostrar el menú que desea consultar.

A continuación se muestran los menús que se pueden visualizar.

Haga clic en [▶] en cada menú para comprobar la información detallada o para cambiar la confi-
guración.

UNSETUP
"BORRAR PARAMET"
Aparece cuando se carga el material. Si se pulsa [ENTER], el material se desesta-
bilizará.

CONDITION
"CONDICION"
Ajuste las condiciones de corte, incluyendo la fuerza de la cuchilla y la veloci-
dad de corte. Los ajustes afectan a la calidad del corte. Cambie las condiciones
de corte según el material que esté utilizando.

P. 22"CONDICION"

SYSTEM INFO.
"SYSTEM INFO."
Compruebe la información del sistema, incluida la versión del firmware, la di-
rección IP y la máscara de subred.

P. 24"SYSTEM INFO."

CROPMARK
<SENSOR MODE>

"REGISTROS"
Ajuste el método de alineación al cortar el material en el que se imprimen las
marcas de corte o las marcas de herramienta. Normalmente se utiliza "MODO
SENSOR".

OTHERS
"OTROS"
Puede ajustar la pantalla o activar o desactivar otros ajustes.

P. 25"OTROS"

REPLOT
<DATA EXISTS>

"REPLOTEAR"
Los datos recibidos del ordenador pueden guardarse en la memoria de la máqui-
na y esos datos pueden utilizarse repetidamente para cortar (recortar).

P. 230Cortar los mismos datos repetidamente

MEMORY
<USER1>

"MEMORIA"
Para ahorrar tiempo en la configuración de las condiciones de corte para cada
cambio de material, puede guardar las condiciones de corte de los materiales
más utilizados en la memoria de la máquina.

P. 233Guardar las condiciones de corte más frecuentes

 ENLACES RELACIONADOS 

Comprobación del menú de la pantalla
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・  P. 179 Imprimir y Cortar en Tool Mode

・  P. 183 Imprimir y Cortar en modo manual

・  P. 199 Optimización de la calidad y la eficiencia

"CONDICION"

Aquí se ajustan y confirman las condiciones de corte, incluyendo la fuerza de la cuchilla y la velocidad de
corte. Los ajustes afectan a la calidad del corte. Cambie las condiciones de corte según el material que
esté utilizando.

• "PRESION"

FORCE 50gf

Se puede ajustar la fuerza de la cuchilla. Si el diseño se despega o si el papel de soporte se corta
también junto con el material, cambie el ajuste de "PRESION". 

P. 204Ajuste la fuerza de la cuchilla

• "VELOC."

SPEED 40cm/s

Se puede ajustar la velocidad de corte. Si la línea de corte está distorsionada o si quedan zonas
parciales sin cortar, cambie el ajuste de "VELOC." 

P. 206Ajuste de la velocidad de corte

• "OFFSET"

OFFSET 0.250mm

Se puede ajustar el desplazamiento de la punta de la cuchilla. Si el comienzo de un corte se desvía
del lugar previsto o si las esquinas de una forma no son limpias, cambie el ajuste de "OFFSET" 

P. 207Ajuste del desplazamiento de la punta de la cuchilla

• "UPSPEED"

UPSPEED 40cm/

Se puede ajustar la velocidad para levantar la cuchilla del material y moverla a la siguiente posi-
ción de corte durante la operación de corte. Cuando corte material más fino o más grueso que el
estándar, cambie el ajuste de "UPSPEED" para evitar problemas como que el material se levante.

P. 213Ajuste de la velocidad de la cuchilla durante el corte

• "ROTAR"

ROTATE 0deg A

Las coordenadas de corte se pueden girar y se puede establecer la dirección de corte del material.

P. 209Establecer la orientación de las coordenadas de corte

• "CALIDAD"

QUALITY NORMAL

Se puede ajustar la calidad de corte. En casos como el uso de material grueso, cambie el ajuste de
"CALIDAD".

Comprobación del menú de la pantalla
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• "EXTENDER"

EXTEND 0.0mm

Puede establecer si se amplía el área de corte en comparación con el ajuste normal o no. Para
aprovechar al máximo el material, cambie la configuración de "EXTENDER".

P. 211Ampliación del área de corte

• "AREA"

AREA 1.0m

Si se utiliza material en rollo, se puede ajustar la longitud del material necesario. Cuando configu-
re el material en rollo, cambie el ajuste de "AREA".

P. 403.  Comprobar la alimentación de material

Comprobación del menú de la pantalla
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"SYSTEM INFO."

Compruebe la información del sistema, incluida la versión del firmware, la dirección IP y la máscara de
subred.

• "MODELO"

SYSTEM INFO.
MODEL

Se puede comprobar el nombre del modelo.

• "SERIAL NO."

SYSTEM INFO.
SERIAL No.

Se puede comprobar el número de serie.

• "FIRMWARE"

SYSTEM INFO.
FIRMWARE

Se puede comprobar la versión del firmware.

• "INTERFACE"

SYSTEM INFO.
INTERFACE

Se puede comprobar la configuración de la conexión con el ordenador.

Para comprobar la configuración de la red, como la dirección IP, pulse dos veces [▶], utilice [▼]
para seleccionar la información que desea mostrar y, a continuación, pulse [▶].

Comprobación del menú de la pantalla
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"OTROS"

Puede ajustar la pantalla o activar o desactivar otros ajustes.

• "SUAVIZADO"

SMOOTHING ON

Puede ajustar las curvas en los datos de corte enviados a esta máquina para suavizarlos.

P. 214Suavizar los arcos de corte y otras curvas (suavizar)

• "UNID."

UNIT mm

Puede ajustar la unidad de la pantalla.

P. 278Modificación de la unidad de longitud a mostrar

• "AJ. DE FABRICA"

FACTORYDEFAULT

Este procedimiento devuelve todos los ajustes a sus valores predeterminados de fábrica. Cualquier
ajuste realizado hasta este punto será eliminado. Mantenga un registro de toda la información ne-
cesaria, como las condiciones de corte.

P. 281Restaurar la configuración predeterminada

• "CONTRASTE"

CONTRAST 5

Puede ajustar el brillo de la pantalla. Cambia la configuración para facilitar la visualización en fun-
ción de tu entorno.

P. 280Ajuste del brillo de la pantalla

• "VENTILADOR"

VACUUMFAN AUTO

Encienda el ventilador de succión para mantener el material en su lugar durante el corte para evi-
tar que el material se levante o se mueva de su lugar. Cuando se utilicen materiales finos y/o poco
firmes, se recomienda reducir el volumen de aire del ventilador de succión.

P. 219Utilice un material más fino o más duro de lo normal

• "ALIMENTAC"

PRE-FEED OFF

El material se alimenta automáticamente antes y durante el corte para evitar la desalineación de
las posiciones de corte. Este ajuste es útil especialmente cuando se cortan datos de 1 m o más.

P. 221Cómo evitar el corte desalineado

• "SOBRECORTADO"

Comprobación del menú de la pantalla
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OVER CUT OFF

Esta función recorta un extra al principio y al final de una línea de corte. Es eficaz cuando se desea
producir esquinas especialmente afiladas, por ejemplo al cortar materiales más gruesos.

P. 217Cortar las esquinas limpiamente (sobrecorte)

• "SOBRECORTAR"

OVERLAP OFF

El corte se repite varias veces en la misma posición con los mismos datos de corte. Utilice este
ajuste para los materiales que no pueden cortarse de una sola pasada, como los materiales grue-
sos.

P. 215Cortar en la misma posición repetidamente (solapamiento)

• "PERFORADO"

PERFORATE OFF

El corte perforado puede utilizarse para cortar material sin papel de soporte o para hacer pliegues
en los datos cortados. La zona de corte se separa tras el corte para evitar que el material se atas-
que.

P. 236Separar la zona de corte posteriormente

• "CROP ADJ."

CROP ADJ.

Si las posiciones de impresión y corte no están alineadas, puede corregir el problema ajustando la
posición de impresión o la posición de corte.

P. 223Ajustar la posición de corte

P. 225Ajustar la posición de impresión

Comprobación del menú de la pantalla
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Posición de carga del material

Cargue el material de manera que los márgenes izquierdo y derecho desde los bordes del material hasta
los rodillos de arrastre sean uniformes. Cargue el material de manera que el rodillo de arrastre (W) se en-
cuentre dentro del rango (Y) del patrón de presión (X).

Dependiendo del ancho del material a cargar, los márgenes izquierdo y derecho pueden no ser uniformes, y el margen
del borde derecho del material puede ser mayor que el margen del borde izquierdo.

NOTA

Z Posición de uso del rodillo de arrastre izquierdo

Rango de uso del rodillo de arrastre izquierdo
Cuando cargue material cuya anchura sea distinta de A a D, mueva el rodillo de arrastre izquierdo.

Rango de uso del rodillo de arrastre derecho con material A cargado

Rango de uso del rodillo de arrastre derecho con material B cargado

Rango de uso del rodillo de arrastre derecho con material C cargado

Rango de uso del rodillo de arrastre derecho con material D cargado

A Material con una anchura de aproximadamente 150 mm

B Material con una anchura de aproximadamente 306 mm

C Material con una anchura de aproximadamente 457 mm

D Material con una anchura de aproximadamente 610 mm

Cuando cargue material distinto al descrito anteriormente, cambie la posición del rodillo de arrastre iz-
quierdo para que se ajuste a la anchura del material.

Preparación del material
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 ENLACES RELACIONADOS 

・  P. 9 Anterior

Preparación del material
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Configuración del material plano

Si se utiliza material plano, debe ser al menos 70 mm más largo que el tamaño vertical de los datos de
corte. Se trata de la longitud necesaria para que el rodillo de presión pueda sacar el material hacia delan-
te o hacia atrás.

Consulte la figura siguiente y asegúrese de que hay suficientes márgenes en la parte delantera y trasera, y
a la derecha e izquierda del material.

50 mm o más

15 mm o más

25 mm o más

No se pueden utilizar materiales con alguna de las siguientes características: Desenrolle y enderece la forma del mate-
rial antes de cargarlo.

• El material se enrosca hacia arriba.
• El borde delantero del material está doblado o arrugado.

IMPORTANTE

1. Carga de material plano

Estas instrucciones describen la forma de colocar el material A4.

Procedimiento

1. Baje la palanca de carga.

No utilice una fuerza excesiva al mover la palanca de carga.
Si lo hiciera, podría dañarlo.

IMPORTANTE

Preparación del material
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2. Introduzca el material por la parte delantera de la máquina.

3. Coloque el material en la posición indicada en la figura siguiente.

La posición difiere según el tamaño del material a cargar.

4. Mueva los rodillos de arrastre hacia los bordes del material para que cada uno esté dentro de los patrones
de presión.

Cargue el material de manera que los márgenes izquierdo y derecho ( ) desde los bordes del ma-
terial hasta los rodillos de arrastre sean uniformes.

Preparación del material
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Cuando utilice material con una gran cantidad de avance (material largo), ajuste los márgenes izquierdo y de-
recho a aproximadamente 25 mm.

NOTA

El material perforado con piñón de arrastre tiene perforaciones a lo largo de cada borde para la alimentación
del material. Si los rodillos de arrastre están colocados sobre las perforaciones, el material no puede alimen-
tarse correctamente. Cuando utilice este material con la máquina, coloque los rodillos de arrastre lejos de las
perforaciones.

NOTA

5. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

6. Levante la palanca de carga.

El material está asegurado en su lugar.

Preparación del material
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Utilice el siguiente enlace para ver un vídeo de referencia para este procedimiento.
Carga de material plano

NOTA

 ENLACES RELACIONADOS 

・  P. 15 Condiciones de los materiales utilizables

・  P. 27 Posición de carga del material

・  P. 343 Área de corte

Preparación del material
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2. Compruebe el material cargado

Procedimiento

1. Encienda la máquina.

2. Pulse varias veces [▼] para seleccionar el "PIEZA".

SELECT SHEET
*PIECE

3. Pulse [ENTER].

El carro de corte se desplaza a la posición del rodillo de arrastre izquierdo y el material se despla-
za hacia delante y hacia atrás.

Al finalizar la inicialización, la anchura y la longitud de corte se muestran en la pantalla.

W:***mm
L:***mm

4. Después de que se detenga el funcionamiento, compruebe los siguientes elementos.

• El borde izquierdo del material no está inclinado hacia la línea guía

• Los rodillos de arrastre no están fuera del material

Vista desde arriba de la máquina

Preparación del material
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NOTA
Cuando el material está inclinado o cuando los rodillos de arrastre están fuera del material, el ma-
terial no puede ser colocado correctamente. Realice el siguiente procedimiento y reinicie la confi-
guración del material desde el principio.

a. Desenganche el material y devuelva el carro de corte a la posición de espera.

P. 174Retirada del material

b. Pulse el botón de encendido durante 1 segundo o más para desconectar la alimentación.

5. Pulse [MENU].

Asegúrese de que se muestren los valores de los elementos.

El valor de la siguiente figura es un ejemplo de referencia.

20cm/s
250gf 0.250mm ∠A
20cm/s
250gf 0.250mm ∠A

Velocidad de corte

Fuerza de la cuchilla

Desplazamiento de la punta de la cuchilla

Orientación de las coordenadas de corte

Si se carga material plano de más de 1,6 m, la máquina lo reconoce como un rollo.
Si este es el caso, haga avanzar el material y confirme que el material puede ser alimentado normalmente.
Si comienza a cortar sin confirmar la alimentación del material, el material puede resbalar durante el corte, o
la calidad del corte puede degradarse con una alimentación inadecuada.

P. 403.  Comprobar la alimentación de material

IMPORTANTE

 ENLACES RELACIONADOS 

・  P. 204 Ajuste la fuerza de la cuchilla

・  P. 207 Ajuste del desplazamiento de la punta de la cuchilla

・  P. 209 Establecer la orientación de las coordenadas de corte

・  P. 206 Ajuste de la velocidad de corte

Preparación del material

34  Operaciones básicas



Configuración del material en rollo

Cuando no se utilice la base de rodillos, corte de antemano del rollo la cantidad necesaria para el corte y cárguelo
como material plano.

P. 29Configuración del material plano

NOTA

1. Carga de material en rollo

Cargue el material en rollo en la máquina utilizando la base de rodillos.

Elemento necesario

Base de rodillos

Cargue el rollo de material correctamente.
De lo contrario, el material podría caerse y provocar lesiones.

PRECAUCIÓN

El rollo de material es aproximadamente 5 kg.
Para evitar lesiones, manipule el rollo de material con cuidado.

PRECAUCIÓN

Nunca cargue material que pese más de 5 kg.
La máquina puede no soportar el peso y volcarse o hacer que el material se caiga.

PRECAUCIÓN

Procedimiento

1. Compruebe que la palanca de carga está bajada.

Preparación del material
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2. Acople la base de rodillos en la máquina.

Sujete el extremo de la máquina al levantarla.

3. Coloque el material en rollo en la base del rodillo.

Cargue el material del rodillo ( ) de manera que las porciones (A) que se extienden más allá de
los bordes izquierdo y derecho de la base del rodillo ( ) sean uniformes.

Cargue el rollo de material correctamente.
De lo contrario, el material podría caerse y provocar lesiones.

PRECAUCIÓN

4. Del rollo, saque el material un poco más largo que la cantidad a utilizar, e introdúzcalo desde la parte
trasera hacia la parte delantera de la máquina.

Preparación del material
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Deje algo de holgura en el material extraído. Si carga el material sin crear algo de holgura, el material no
podrá avanzar correctamente.

IMPORTANTE

5. Mueva los rodillos de arrastre hacia los bordes del material y dentro de los patrones de presión.

Coloque los rodillos de arrastre de manera que cada uno esté a 25 mm o más ( ) hacia dentro del
respectivo borde izquierdo o derecho del material.

El material perforado con piñón de arrastre tiene perforaciones a lo largo de cada borde para la alimentación
del material. Si los rodillos de arrastre están colocados sobre las perforaciones, el material no puede alimen-
tarse correctamente. Cuando utilice este material con la máquina, coloque los rodillos de arrastre lejos de las
perforaciones.

NOTA

Preparación del material
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6. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

7. Levante la palanca de carga.

El material está asegurado en su lugar.

Utilice el siguiente enlace para ver un vídeo de referencia para este procedimiento.
Carga de material en rollo

NOTA

 ENLACES RELACIONADOS 

・  P. 15 Condiciones de los materiales utilizables

・  P. 27 Posición de carga del material

Preparación del material
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2. Seleccione el tipo de material

Seleccione el tipo de material que se va a cargar en la máquina.

Procedimiento

1. Encienda la máquina.

Aparece la pantalla que se muestra en la siguiente figura.

SELECT SHEET
ROLL

2. Pulse [▲] o [▼] para seleccionar "ROLLO" o "BORDE".

Si se selecciona y ajusta "BORDE", se reservan aproximadamente 15 mm ( ) del borde superior del
material para el margen. Si se selecciona y ajusta
"ROLLO", no se reserva ningún margen.

3. Pulse [ENTER].

El carro de corte se mueve hacia el borde izquierdo. La anchura de corte aparece entonces en la
pantalla.

W:261mm
L:----  [0mm]

 ENLACES RELACIONADOS 

・  P. 35 Carga de material en rollo

Preparación del material
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3. Comprobar la alimentación de material

Antes de cortar, haga avanzar el material y confirme que el material puede alimentarse normalmente.

Si comienza a cortar sin confirmar la alimentación del material, el material puede resbalar durante el cor-
te, o la calidad del corte puede degradarse con una alimentación inadecuada.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] para que aparezca la siguiente pantalla.

CONDITION

3. Pulse [▶], y a continuación [▲] para visualizar la pantalla que se muestra a continuación.

Aparece la pantalla que se muestra en la siguiente figura.

AREA 1.0m

4. Pulse [▶].

5. Pulse [▲][▼] para ajustar la longitud de material necesaria para los datos de corte.

Para que el rodillo de presión haga avanzar el material, hay que dejar márgenes al principio y al
final de la zona de corte. Es una buena idea establecer un valor que sea aproximadamente 0,2 m
más largo que la longitud de material requerida.

AREA 1.0m
*-24.9m

6. Pulse [ENTER].

La longitud establecida del material se desplaza hacia el frente, e inmediatamente se retira y se
vuelve a recoger.

Si el material se escapa de los rodillos de arrastre, pulse [PAUSE] para detener el funcionamiento.
Baje la palanca de carga, saque el material y vuelva a realizar la configuración desde el principio.

7. Pulse [MENU] para volver a la pantalla original.

 ENLACES RELACIONADOS 

・  P. 15 Material utilizado

・  P. 29 Carga de material plano

・  P. 35 Carga de material en rollo
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Paso 1: Prepare la cuchilla

No toque jamás la punta de la cuchilla.
Si lo hiciera, podría lesionarse. El rendimiento de corte de la cuchilla también podría verse alterado.

PRECAUCIÓN

Elementos necesarios (elementos incluidos)

Soporte de la cuchilla Cuchilla Pasador *1

 

*1 El pasador se introduce en el soporte.
 

Procedimiento

1. Si se ha retirado el pasador del portacuchillas, insértelo en el portacuchillas.

2. Gire la tapa del portacuchillas en el sentido de las agujas del reloj y apriétela hasta que deje de girar.

3. Inserte la cuchilla.

Preparativos para la salida de corte
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Las condiciones de corte, como la cantidad de corte, la velocidad de corte, la fuerza de la cuchilla, etc., de-
ben ajustarse al tipo de material.
Asegúrese de realizar pruebas de corte con el material que se va a utilizar y ajuste las condiciones de corte.

IMPORTANTE

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

・  P. 202 Ajuste de la configuración de corte
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Paso 2: Instale el soporte de la cuchilla

No toque jamás la punta de la cuchilla.
Si lo hiciera, podría lesionarse. El rendimiento de corte de la cuchilla también podría verse alterado.

PRECAUCIÓN

Procedimiento

1. Afloje el tornillo del carro de corte.

2. Inserte el soporte de la cuchilla.

Confirme que el soporte de la cuchilla y el carro de corte están acoplados.

3. Apriete el tornillo del carro de corte.

Preparativos para la salida de corte
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Utilice el siguiente enlace para ver un vídeo de referencia para este procedimiento.
Preparación de la cuchilla

NOTA

Preparativos para la salida de corte
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Paso 3: Realizar corte de prueba

Ajuste las condiciones de corte según los tipos de material y la limpieza del corte. Para obtener resultados
de corte de alta calidad, realice una prueba de corte para comprobar la calidad de corte del material an-
tes de realizar el corte real.

Procedimiento

1. Compruebe que el deslizador PEN FORCE está en la posición central (en «0» en la escala).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Pulse [▲][▼][◀][▶] para mover el carro de corte.

Mueva el carro de corte para que la punta de la cuchilla apunte a la posición inicial del corte.

Para mover el material o el carro de corte rápidamente, pulse [ENTER] junto con uno de [▲][▼][◀][▶] mien-
tras se muestra una de las siguientes pantallas.

20cm/s
250gf 0.250mm ∠A

W:***mm
L:***mm

NOTA

3. Mantenga pulsado [TEST] durante un segundo o más.

El corte del patrón de prueba comenzará en la posición de la cuchilla en la que se pulse [TEST].

4. Una vez completado el corte, pulse [▼] para hacer avanzar el material.
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▲
▲ ▲▲

5. Despegue la forma cortada utilizando unas pinzas, etc. para verificar la calidad del corte.

Las siguientes condiciones son signos de buena calidad.

• Cuando se pela la parte del círculo, solo se desprende la parte del círculo

• Al despegar la parte cuadrada, queda un tenue rastro de cuchilla en el papel de soporte

Si se da alguna de las siguientes condiciones, ajuste la fuerza de la cuchilla o la velocidad de cor-
te. Después del ajuste, vuelva a realizar una prueba de corte. Repita este proceso hasta obtener
una buena calidad.

Comprobar elemento Resultado Elemento de con-
figuración

Ajuste

Compruebe la forma. La forma del corte está distorsionada. Velocidad de corte Reducir

Desprenda el círculo. Otras formas se desprenden juntas Fuerza de la cu-
chilla

Incremento

El papel de soporte también se corta Reducir

Quedan algunas áreas sin cortar. Velocidad de corte Reducir

Desprenda el cuadrado. El rastro de la cuchilla no se puede ver Fuerza de la cu-
chilla

Incremento

El rastro de la cuchilla es demasiado
profundo

Reducir

Si se utiliza un material duro o un papel de soporte fino, es posible que al cambiar la fuerza de la cuchilla no
se obtenga una buena calidad. Ajuste la cantidad de extensión de la punta de la cuchilla y ajuste con precisión
la cantidad de corte.

IMPORTANTE

Utilice el siguiente enlace para ver un vídeo de referencia para este procedimiento.
Prueba de corte

NOTA

 ENLACES RELACIONADOS 

Preparativos para la salida de corte
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・  P. 201 Guía general sobre las condiciones de corte

・  P. 204 Ajuste la fuerza de la cuchilla

・  P. 206 Ajuste de la velocidad de corte

・  P. 202 Ajustar la profundidad de corte

Preparativos para la salida de corte
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Paso 4: Ajuste de la posición de inicio de impresión

Antes de cortar, ajuste la ubicación de inicio de salida a un lugar donde se pueda asegurar un área de cor-
te adecuada.

Imprime el corte real en un área que no se superpone con el área utilizada para las pruebas de corte.

Procedimiento

1. Pulse [◀][▲] para mover el carro de corte a la posición que desee establecer como origen.

Mueva el carro de corte hasta que la punta de la cuchilla apunte al lugar que desea establecer co-
mo origen.

2. Pulse [▲] para hacer retroceder el material y asegúrese de que las huellas de la prueba de corte están
delante del protector de la cuchilla.

La cuchilla se mueve sobre el protector de la cuchilla. Cuando se ajusta el origen, el área detrás
del protector de la cuchilla se establece como área de corte.

3. Mantenga pulsado [ORIGIN] durante un segundo o más.

La pantalla parpadea y la ubicación de la punta de la cuchilla se establece como origen.

Preparativos para la salida de corte
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Paso 1: Crear datos de corte

Introduzca texto y formas, y cree datos de corte. Esta sección explica cómo crear datos de corte que con-
tengan «SALE», y añadir una «línea de maleza», que facilita el pelado posterior.

Procedimiento

1. Inicia CutStudio.

• Windows 11

a. Haga clic en [Start].

b. Haga clic en [Todas las aplicaciones]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Haga clic en [Start].

b. Haga clic en [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Haga clic en  en la parte inferior izquierda de la ventana [Start] para mostrar la venta-
na [Apps].

b. Haga clic en .

Se inicia CutStudio.

2. Haga clic en .

3. Haga clic en cualquier lugar y escriba «SALE».

Método de corte
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4. Haga clic en  y cambie el tamaño de los caracteres.

 y  aparecen alrededor del texto. Arrastre  o  para cambiar el tamaño del texto.

Para especificar el tamaño del texto en valores, seleccione el objeto de destino y haga clic en .

NOTA

5. Haga clic en [Object]>[Weed].

Aparece la ventana [Weed].

Método de corte
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6. Seleccione la casilla [Weed Border] y, a continuación, haga clic en[OK].

Se añade una línea de eliminación de residuos alrededor de los personajes.

Método de corte
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El objeto introducido se agrupa con su línea de maleza. Para obtener detalles sobre las líneas de
maleza, consulte la Ayuda de CutStudio.

Método de corte
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7. Haga clic en un objeto y luego en .

El objeto se mueve hacia el origen.

El origen mostrado en CutStudio indica la posición de inicio de salida del material cargado.
Al posicionar el objeto en el origen, se puede evitar el exceso de alimentación de material.

NOTA

8. Haga clic en .

Método de corte
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9. Seleccione la carpeta en la que desea guardar los datos, introduzca el nombre del archivo y haga clic en
[Save].

Los datos creados se guardan.

Método de corte

56  Creación de datos de corte con CutStudio



Paso 2: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

3. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

4. Haga clic en [Change] bajo [Media Size].

Método de corte
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5. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

6. Haga clic en [OK].

Método de corte
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La configuración se guarda y aparece la ventana [Cutting Setup].

7. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

8. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA
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Paso 3: Cortando

Envía los datos de corte a la máquina y corta el material.

Si el material se desprende o la máquina funciona de forma anómala, pulse [PAUSE] para cancelar la salida.
Baje la palanca de carga, saque el material y vuelva a realizar la configuración desde el principio.

IMPORTANTE

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Comienza el corte.

 ENLACES RELACIONADOS 

・  P. 177 Pausa y cancelación de la salida

・  P. 27 Preparación del material

Método de corte
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Paso 1: Crear datos de Imprimir y Cortar

1. Coloque los datos de impresión

CutStudio solo puede leer los siguientes tipos de archivos.

• Formato JPEG (no se pueden leer los archivos JPEG guardados en formato CMYK)
• Formato PNG
• Formato BMP
• Formatos AI y EPS (solo versión Illustrator 8.0. Si utiliza una versión superior, baje la versión al guardar)

NOTA

Procedimiento

1. Inicia CutStudio.

• Windows 11

a. Haga clic en [Start].

b. Haga clic en [Todas las aplicaciones]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Haga clic en [Start].

b. Haga clic en [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Haga clic en  en la parte inferior izquierda de la ventana [Start] para mostrar la venta-
na [Apps].

b. Haga clic en .

Se inicia CutStudio.

2. Seleccione [File]>[Print&Cut] en CutStudio.

El área de impresión y las marcas de corte aparecen en la pantalla. El área de impresión se mues-
tra con líneas de puntos. Las marcas de corte se mostrarán en el área donde los márgenes especifi-
cados en [Printing Setup] se excluyen del tamaño del material especificado en [Set up the prin-
ter].

Método de impresión y corte
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3. Haga clic en  para importar los datos de impresión.

Aquí, Sample.bmp que se encuentra en la carpeta donde está instalado CutStudio (normalmente
situada en la carpeta [Program Files (x86)]>[CutStudio] de la unidad C) se abre como datos de
impresión.

4. Seleccione los datos de impresión y haga clic en [Open].

Método de impresión y corte
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5. Coloque los datos de impresión en el área dentro de las marcas de corte.

Puede cambiar la densidad de la imagen importada.

 ENLACES RELACIONADOS 

・  P. 83 Cambiar la oscuridad de la imagen colocada

・  P. 333 No se pueden importar los datos de Illustrator

・  P. 334 No se pueden encontrar los datos de la muestra
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2. Añada líneas de corte a los datos de impresión

Añada líneas de corte a los datos de impresión, que se leen en CutStudio, y cree los datos de Imprimir y
Cortar.

Procedimiento

1. Seleccione  y dibuje las líneas de corte.

Aquí se dibuja una línea de corte alrededor de los datos de impresión, como se muestra a conti-
nuación ( ).

2. Haga clic en .

3. Seleccione la carpeta en la que desea guardar los datos, introduzca el nombre del archivo y haga clic en
[Save].

Los datos de Imprimir y Cortar que ha creado se guardan.

Método de impresión y corte
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Paso 2: Ajuste las condiciones de impresión

Ajuste el rango de impresión para Imprimir y Cortar así como las marcas de corte.

Procedimiento

1. Haga clic en [File]>[Printing Setup].

2. Haga clic en [Set up the printer].
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3. Ajuste el tamaño del documento y, a continuación, haga clic en [OK].

4. Seleccione el número de marcas de corte.

Seleccione [4] o [3] de [Layout Points].

Método de impresión y corte
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[4] Marcas de corte: 4 puntos

[3] Marcas de corte: 3 puntos

Normalmente se utiliza [4].
Como [3] tiene menos marcas de corte que leer que [4], se ahorra el tiempo necesario para el corte, pero esto
no está disponible en el Tool Mode.

NOTA

5. Haga clic en [Fit into shared area for cutting and printing].

La ubicación de la marca de corte se establece automáticamente.
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Cuando configure las posiciones de las marcas de corte manualmente, consulte la tabla siguiente y especifique
los márgenes y la distancia entre las marcas de corte. Cuando utilice material con gran cantidad de avance
(material largo), le recomendamos que ajuste los márgenes izquierdo y derecho a aproximadamente 25 mm.

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 4 marcas de
corte (Unidad: mm)

Elemento de configuración A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 59 59 61 58 56

[Bottom] 20 20 20 20 20 20

[Left] 10 30 30 15 15 14

[Right] 10 16 16 14 16 14

[Crop
marks]

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 3 marcas de
corte (Unidad: mm)

Elemento de configuración A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 60 60 62 59 57

[Bottom] 20 20 20 20 20 20

[Left] 15 30 30 15 15 15

[Right] 15 17 17 15 17 14

[Crop
marks]

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

NOTA

6. Haga clic en [OK].

Después de ajustar los valores, compruebe que las marcas de corte están dentro del área de im-
presión.

Si se utiliza un material mayor que los tamaños indicados en la tabla, se deben ajustar los valores consultando
Los márgenes y la distancia entre las marcas de corte(P. 344).

NOTA
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Paso 3: Salida de datos de Imprimir y Cortar

1. Imprima los datos de Imprimir y Cortar

Envíe los datos de impresión de CutStudio a la impresora e imprima los datos de Imprimir y Cortar.

Procedimiento

1. Cargue el material en la impresora.

Para saber cómo cargar el material en la impresora, consulte la documentación de la misma.

Si la impresión ampliada/reducida está activada, desactívela. Asegúrese de imprimir a escala 100 %.

IMPORTANTE

2. Haga clic en .

Aparece la ventana [Print].

3. Seleccione la impresora que desea utilizar y, a continuación, haga clic en[OK].

Solo se imprimirán los datos de impresión.

Método de impresión y corte

Creación de datos de corte con CutStudio 71



2. Cargue el material impreso

Cargue el material impreso desde una impresora a la máquina.

No se puede utilizar material enroscado, ya que las marcas de corte pueden no ser legibles. Si el material se curva al
imprimirlo, alíselo antes de cargarlo en la máquina.

IMPORTANTE

Procedimiento

1. Compruebe el origen del corte ( ) en el material.

2. Coloque el material situando su origen para el corte en la parte inferior izquierda de la máquina.

Si el material se carga en una dirección incorrecta, la máquina no podrá leer las marcas de corte.

IMPORTANTE

3. Coloque los rodillos de arrastre.

Tenga en cuenta los siguientes puntos al colocar los rodillos de arrastre.

• Colocar los rodillos de arrastre ( ) hacia el exterior de las marcas de la herramienta ( )

• Asegúrese de que los rodillos de arrastre ( ) están ajustados dentro del rango de los patrones
de presión ( )

Método de impresión y corte

72  Creación de datos de corte con CutStudio



Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utili-
ce material en tamaños distintos a A3, A4 o B4.

• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al
menos 30 mm (W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia
despejada es inferior a 30 mm, la marca de corte no puede leerse.

NOTA

4. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

5. Levante la palanca de carga.
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El material está asegurado en su lugar.

6. Encienda la máquina.

7. Seleccione [PIEZA] como tipo de material.

8. Pulse [ENTER].

Se muestran el ancho y la longitud de corte.

W:***mm
L:***mm

9. Pulse [▲][▼] para mover el material y posicionar la marca de corte ( ) sobre el protector de la cuchilla
( ).

Las marcas de corte no pueden leerse en las situaciones indicadas a continuación. Retire el material una vez y
vuelva a cargarlo.

• Las marcas de corte están separadas del protector de la cuchilla ( ) por una distancia de 15 mm o más( )
• Las marcas de corte izquierda y derecha están inclinadas 5 grados o más ( ) con respecto a la dirección de

desplazamiento del carro de corte
• Las marcas de corte izquierda y derecha se desvían 20 mm o más ( ) en la dirección de avance del mate-

rial

IMPORTANTE
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10. Pulse [◀][▶] para mover el carro de corte de forma que la punta de la cuchilla pase por el centro de la
marca de corte inferior izquierda.
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Paso 4: Configure el ajuste para realizar la alineación automática

Coloque las marcas de corte automáticamente mediante el sensor integrado en la máquina.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<TOOL MODE>

3. Pulse [▶].

4. Pulse [▲] o [▼] para seleccionar "MODO SENSOR".

CROPMARK
 SENSOR MODE

5. Pulse [ENTER] para seleccionar el ajuste.

6. Pulse [MENU] para volver a la pantalla original.
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Paso 5: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

3. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

4. Haga clic en [Change] bajo [Media Size].
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5. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

6. Haga clic en [OK].
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La configuración se guarda y aparece la ventana [Cutting Setup].

7. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

8. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA
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Paso 6: Cortando

Envíe los datos de Imprimir y Cortar a la máquina y comience a cortar.

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Los datos de Imprimir y Cortar se envían a la máquina. Cuando la máquina recibe los datos de Im-
primir y Cortar, lee automáticamente las marcas de corte mediante un sensor y, a continuación,
comienza a cortar.

Si el sensor no lee las marcas de corte, aparece la pantalla que se muestra a continuación.

Si aparece la siguiente pantalla, consulte No se detectan las marcas de corte(P. 298) para resolver el
error.

SET TO
<TOOL MODE>

Si esto no resuelve el problema, cambie al Tool Mode y realice la alineación 

NOTA
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P. 179Imprimir y Cortar en Tool Mode

3. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material

Método de impresión y corte
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Esta sección proporciona métodos de uso útiles para crear datos utilizando CutStudio.

Cambiar la oscuridad de la imagen colocada

Puede cambiar la oscuridad de una imagen importada en CutStudio.

Procedimiento

1. Haga clic en [File]>[Preference].

2. Ajuste el [General]>[Image Darkness].

• Rango de ajuste: 1 a 100 %

Métodos avanzados de creación de datos
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3. Haga clic en [OK].

Métodos avanzados de creación de datos
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Cambiar a fuentes verticales

Este procedimiento no admite fuentes alfabéticas.

IMPORTANTE

Procedimiento

1. Utilice  para seleccionar los caracteres que desea cambiar a texto vertical.

2. Haga clic en .

El panel de conexión se abre.

3. Después de seleccionar el panel [Format], seleccione la casilla [Vertical writing font].

El texto pasa de estar escrito en horizontal a estarlo en vertical.
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Si desea cambiar la orientación de los caracteres, utilice [Angle of Rotation] en el panel [Size and shape].

NOTA

4. Selección de fuentes

Aparecen las fuentes japonesas que admiten la escritura vertical.

Métodos avanzados de creación de datos

86  Creación de datos de corte con CutStudio



Mover un símbolo guardado a un nuevo ordenador

Para obtener instrucciones sobre cómo guardar símbolos, consulte la Ayuda de CutStudio.

NOTA

Procedimiento

1. Copie la carpeta [Symbol] de la ruta de acceso siguiente.

• C:\ProgramData\Roland DG Corporation\CutStudio\Symbol

Si la carpeta no se muestra, compruebe la configuración de visualización de archivos ocultos.

P. 334No se pueden encontrar los datos de la muestra

NOTA

2. Copie la carpeta [Symbol] en el nuevo ordenador.

Copie la carpeta en la misma ubicación en el nuevo ordenador.

Métodos avanzados de creación de datos
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Esta sección describe cómo crear datos de corte con Adobe Illustrator y cómo realizar el corte.

Para imprimir los datos de corte creados con Adobe Illustrator a CutStudio, es necesario instalar el comple-
mento CutStudio para Adobe Illustrator.

Para obtener información sobre las últimas versiones compatibles, visite el sitio web de DGSHAPE Corpora-
tion (https://www.rolanddg.co.jp/).

 ENLACES RELACIONADOS 

・ GS2-24 Installation and Initial Settings Windows Version

Paso 1: Crear datos de corte

Introduzca texto y formas, y cree datos de corte. Esta sección explica cómo crear datos de corte utilizando
Adobe Illustrator 2020. El procedimiento de operación es el mismo para otras versiones.

Procedimiento

1. Inicie Adobe Illustrator.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

Método de corte
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3. Crea un nuevo documento.

Ajuste el tamaño del documento en uno de los tamaños de corte, que se muestran en la pantalla
del equipo después de configurar el material.

4. Introduzca texto y formas.

En este ejemplo, introducimos «SALE» y dibujamos una línea para rodear la palabra. Esta línea se
llama «línea de maleza» y se utiliza para facilitar la eliminación de los datos cortados.

Contornear el texto. Al elegir el texto y hacer clic en  en la paleta [Roland CutStudio], el texto se con-
vierte en un contorno.

NOTA

Método de corte
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Paso 2: Salida de datos de corte a CutStudio

Puede enviar a CutStudio los datos de las líneas de corte realizadas con Adobe Illustrator.

Procedimiento

1. Seleccione [Output All Lines] en la paleta [Roland CutStudio].

2. Seleccione la casilla [Auto Update] en la paleta.

Se muestra una vista previa del objeto que se va a imprimir.

3. Haga clic en .

Se inicia CutStudio y los datos de la línea de corte se envían a CutStudio.

Los datos de salida siempre se alinean en el origen de CutStudio independientemente de la posición en Adobe
Illustrator. (Esto no se aplica a los datos con marcas de corte)

NOTA
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Paso 3: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

3. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

4. Haga clic en [Change] bajo [Media Size].

Método de corte
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5. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

6. Haga clic en [OK].
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La configuración se guarda y aparece la ventana [Cutting Setup].

7. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

8. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA
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Paso 4: Cortando

Envía los datos de corte a la máquina y corta el material.

Si el material se desprende o la máquina funciona de forma anómala, pulse [PAUSE] para cancelar la salida.
Baje la palanca de carga, saque el material y vuelva a realizar la configuración desde el principio.

IMPORTANTE

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Comienza el corte.

 ENLACES RELACIONADOS 

・  P. 27 Preparación del material

Método de corte
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Comprobación de la ayuda de Adobe Illustrator

Procedimiento

1. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

2. En la paleta, haga clic en .

3. Haga clic en [Help].
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Paso 1: Ajuste las condiciones de impresión

Ajuste el rango de impresión para Imprimir y Cortar así como las marcas de corte.

Procedimiento

1. Inicie Adobe Illustrator y abra un nuevo documento.

Ajuste la mesa de trabajo.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

Método de impresión y corte
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3. En la paleta, haga clic en .

Las marcas de corte se insertan en la mesa de trabajo.

4. Haga clic en  en la paleta, y luego haga clic en [Crop-marks].

5. Ajuste el [Type], [Point].

Para [Type], seleccione «GS2-24».

[Point] indica el número de marcas de corte.

Cuando [Point] es «4» Marcas de corte: 4 puntos

Cuando [Point] es «3» Marcas de corte: 3 puntos

Normalmente, seleccione «4» en [Point]. Cuando [Point] es «3», el Tool Mode no está disponible.

6. Ajuste el margen y la distancia entre las marcas de corte, y luego haga clic en [OK].

Para conocer los detalles sobre los márgenes y la distancia entre las marcas de corte, consulte la
tabla siguiente. Cuando utilice material con gran cantidad de avance (material largo), le recomen-
damos que ajuste los márgenes izquierdo y derecho a aproximadamente 25 mm.

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 4 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315
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A4 A3 B4

Y X Y X Y X

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 3 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si utiliza un material más grande que los tamaños indicados anteriormente, ajuste los valores consultando Los
márgenes y la distancia entre las marcas de corte(P. 344).

NOTA

Las marcas de corte se muestran en la mesa de trabajo.

Método de impresión y corte

102  Creación de datos de corte con Adobe Illustrator (Windows)



Paso 2: Crear datos de Imprimir y Cortar

1. Coloque los datos de impresión

Procedimiento

1. Haga clic en [File]>[Placement] para importar los datos de impresión.

Aquí, Sample.bmp que se encuentra en la carpeta donde está instalado CutStudio (normalmente
situada en la carpeta [Program Files (x86)]>[CutStudio] de la unidad C) se abre como datos de
impresión.

2. Seleccione los datos de impresión y haga clic en [Layout Points].

3. Coloque los datos de impresión en el área dentro de las marcas de corte.

Método de impresión y corte
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2. Añada líneas de corte a los datos de impresión

Añada líneas de corte a los datos de impresión posicionados y cree los datos de Imprimir y Cortar.

Procedimiento

1. Cree una nueva capa para las líneas de corte y dibuje allí las líneas de corte.

Aquí se dibuja una línea de corte alrededor de los datos de impresión, como se muestra a conti-
nuación ( ).

2. Haga clic en [File]>[Save].

3. Seleccione la carpeta en la que desea guardar los datos, introduzca el nombre del archivo y haga clic en
[Save].

Los datos de Imprimir y Cortar que ha creado se guardan.
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Paso 3: Salida de datos de Imprimir y Cortar

1. Imprima los datos de Imprimir y Cortar

Envíe los datos de impresión a la impresora e imprima los datos de Imprimir y Cortar.

Procedimiento

1. Cargue el material en la impresora.

Para saber cómo cargar el material en la impresora, consulte la documentación de la misma.

Si la impresión ampliada/reducida está activada, desactívela. Asegúrese de imprimir a escala 100 %.

IMPORTANTE

2. Oculte la capa que contiene las líneas de corte.

3. Haga clic en [File]>[Print].

4. Compruebe la configuración de impresión y haga clic en [Print].

Solo se imprimirán los datos de impresión.

Método de impresión y corte
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2. Cargue el material impreso

Cargue el material impreso desde una impresora a la máquina.

No se puede utilizar material enroscado, ya que las marcas de corte pueden no ser legibles. Si el material se curva al
imprimirlo, alíselo antes de cargarlo en la máquina.

IMPORTANTE

Procedimiento

1. Compruebe el origen del corte ( ) en el material.

2. Coloque el material situando su origen para el corte en la parte inferior izquierda de la máquina.

Si el material se carga en una dirección incorrecta, la máquina no podrá leer las marcas de corte.

IMPORTANTE

3. Coloque los rodillos de arrastre.

Tenga en cuenta los siguientes puntos al colocar los rodillos de arrastre.

• Colocar los rodillos de arrastre ( ) hacia el exterior de las marcas de la herramienta ( )

• Asegúrese de que los rodillos de arrastre ( ) están ajustados dentro del rango de los patrones
de presión ( )

Método de impresión y corte

Creación de datos de corte con Adobe Illustrator (Windows) 107



Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utili-
ce material en tamaños distintos a A3, A4 o B4.

• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al
menos 30 mm (W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia
despejada es inferior a 30 mm, la marca de corte no puede leerse.

NOTA

4. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

5. Levante la palanca de carga.
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El material está asegurado en su lugar.

6. Encienda la máquina.

7. Seleccione [PIEZA] como tipo de material.

8. Pulse [ENTER].

Se muestran el ancho y la longitud de corte.

W:***mm
L:***mm

9. Pulse [▲][▼] para mover el material y posicionar la marca de corte ( ) sobre el protector de la cuchilla
( ).

Las marcas de corte no pueden leerse en las situaciones indicadas a continuación. Retire el material una vez y
vuelva a cargarlo.

• Las marcas de corte están separadas del protector de la cuchilla ( ) por una distancia de 15 mm o más( )
• Las marcas de corte izquierda y derecha están inclinadas 5 grados o más ( ) con respecto a la dirección de

desplazamiento del carro de corte
• Las marcas de corte izquierda y derecha se desvían 20 mm o más ( ) en la dirección de avance del mate-

rial

IMPORTANTE
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10. Pulse [◀][▶] para mover el carro de corte de forma que la punta de la cuchilla pase por el centro de la
marca de corte inferior izquierda.
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Paso 4: Configure el ajuste para realizar la alineación automática

Coloque las marcas de corte automáticamente mediante el sensor integrado en la máquina.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<TOOL MODE>

3. Pulse [▶].

4. Pulse [▲] o [▼] para seleccionar "MODO SENSOR".

CROPMARK
 SENSOR MODE

5. Pulse [ENTER] para seleccionar el ajuste.

6. Pulse [MENU] para volver a la pantalla original.
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Paso 5: Envíe los datos de Imprimir y Cortar a CutStudio

Procedimiento

1. Muestre la capa que contiene las líneas de corte dibujadas por Adobe Illustrator y selecciónela.

2. En la paleta [Roland CutStudio], seleccione [Output Current Layer] y luego haga clic en [Update].

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

3. Haga clic en .

Se inicia CutStudio y los datos de la línea de corte se envían a CutStudio.
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Paso 6: Ajuste de las condiciones de corte

Procedimiento

1. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

2. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

3. Haga clic en [Change] bajo [Media Size].
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4. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

5. Haga clic en [OK].
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La configuración se guarda y aparece la ventana [Cutting Setup].

6. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

7. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA

Método de impresión y corte

Creación de datos de corte con Adobe Illustrator (Windows) 115



Método de impresión y corte

116  Creación de datos de corte con Adobe Illustrator (Windows)



Paso 7: Cortando

Envíe los datos de Imprimir y Cortar a la máquina y comience a cortar.

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Los datos de Imprimir y Cortar se envían a la máquina. Cuando la máquina recibe los datos de Im-
primir y Cortar, lee automáticamente las marcas de corte mediante un sensor y, a continuación,
comienza a cortar.

Si el sensor no lee las marcas de corte, aparece la pantalla que se muestra a continuación.

Si aparece la siguiente pantalla, consulte No se detectan las marcas de corte(P. 298) para resolver el
error.

Si esto no resuelve el problema, cambie al Tool Mode y realice la alineación.

P. 179Imprimir y Cortar en Tool Mode

NOTA
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SET TO
<TOOL MODE>

3. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material

Método de impresión y corte
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Esta sección describe cómo crear datos de corte con Adobe Illustrator y cómo realizar el corte.

Para la salida los datos de corte creados con Adobe Illustrator, es necesario instalar el complemento CutS-
tudio para Adobe Illustrator.

Para obtener información sobre las últimas versiones compatibles, visite el sitio web de DGSHAPE Corpora-
tion (https://www.rolanddg.co.jp/).

 ENLACES RELACIONADOS 

・ GS2-24 Installation and Initial Settings For Macintosh Computers

Paso 1: Crear datos de corte

Introduzca texto y formas, y cree datos de corte. Esta sección explica cómo crear datos de corte utilizando
Adobe Illustrator 2020. El procedimiento de operación es el mismo para otras versiones.

Procedimiento

1. Inicie Adobe Illustrator.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].
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3. Crea un nuevo documento.

Ajuste el tamaño del documento en uno de los tamaños de corte, que se muestran en la pantalla
del equipo después de configurar el material.

4. Introduzca texto y formas.

En este ejemplo, introducimos «SALE» y dibujamos una línea para rodear la palabra. Esta línea se
llama «línea de maleza» y se utiliza para facilitar la eliminación de los datos cortados.

Contornear el texto. Al elegir el texto y hacer clic en  en la paleta [Roland CutStudio], el texto se con-
vierte en un contorno.

NOTA

Método de corte
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Paso 2: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. En el panel [Roland CutStudio], seleccione [GS2-24] en [Model].

3. En el panel, haga clic en [Update Information].

El rango de corte se adquiere de la máquina conectada, y la pantalla en [Media] se actualizará.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

4. Haga clic en  en la paleta, y luego haga clic en [Preferences].

5. Seleccione la casilla [Use Cut Setting].
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6. Haga clic en [OK].

7. Haga clic en  en la paleta, y luego haga clic en [Cut Setting].

[Cut Setting] se muestra seleccionando [Cut Setting].

8. Ajustar las condiciones de corte.

Normalmente, la casilla [Use Machine Setting] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use Machine Setting] e introduzca los
valores.

9. Haga clic en [OK].
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Se guardan el rango y las condiciones de corte.
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Paso 3: Cortando

Envía los datos de corte a la máquina y corta el material.

Si el material se desprende o la máquina funciona de forma anómala, pulse [PAUSE] para cancelar la salida.
Baje la palanca de carga, saque el material y vuelva a realizar la configuración desde el principio.

IMPORTANTE

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. En la paleta [Roland CutStudio], seleccione [Output All Lines] y luego haga clic en [Update].

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

2. En la paleta, haga clic en .

3. Seleccione [Roland GS2-24] y haga clic en [Cut].

Comienza el corte.

Si el nombre del modelo no aparece, consulte La máquina no funciona.

4. Una vez terminado el corte, haga clic en [Exit] para cerrar la ventana.

Método de corte

126  Creación de datos de corte con Adobe Illustrator (Mac)



Paso 1: Ajuste las condiciones de impresión

Ajuste el rango de impresión para Imprimir y Cortar así como las marcas de corte.

Procedimiento

1. Inicie Adobe Illustrator y abra un nuevo documento.

Ajuste la mesa de trabajo.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

3. En la paleta, haga clic en .

Las marcas de corte se insertan en la mesa de trabajo.

4. Haga clic en  en la paleta, y luego haga clic en [Crop-marks].
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5. Ajuste el [Type], [Point].

Para [Type], seleccione «GS2-24».

[Point] indica el número de marcas de corte.

Cuando [Point] es «4» Marcas de corte: 4 puntos

Cuando [Point] es «3» Marcas de corte: 3 puntos

Normalmente, seleccione «4» en [Point]. Cuando [Point] es «3», el Tool Mode no está disponible.

6. Ajuste el margen y la distancia entre las marcas de corte, y luego haga clic en [OK].

Para conocer los detalles sobre los márgenes y la distancia entre las marcas de corte, consulte la
tabla siguiente. Cuando utilice material con gran cantidad de avance (material largo), le recomen-
damos que ajuste los márgenes izquierdo y derecho a aproximadamente 25 mm.

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 4 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 3 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325
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A4 A3 B4

Y X Y X Y X

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si utiliza un material más grande que los tamaños indicados anteriormente, ajuste los valores consultando Los
márgenes y la distancia entre las marcas de corte(P. 344).

NOTA

Las marcas de corte se muestran en la mesa de trabajo.
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Paso 2: Crear datos de Imprimir y Cortar

1. Coloque los datos de impresión

Procedimiento

1. Haga clic en [File]>[Placement] para importar los datos de impresión.

2. Coloque los datos de impresión en el área dentro de las marcas de corte.
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2. Añada líneas de corte a los datos de impresión

Añada líneas de corte a los datos de impresión posicionados y cree los datos de Imprimir y Cortar.

Procedimiento

1. Cree una nueva capa para las líneas de corte y dibuje allí las líneas de corte.

Aquí se dibuja una línea de corte alrededor de los datos de impresión, como se muestra a conti-
nuación ( ).

2. Haga clic en [File]>[Save].

3. Seleccione la carpeta en la que desea guardar los datos, introduzca el nombre del archivo y haga clic en
[Save].

Los datos de Imprimir y Cortar que ha creado se guardan.
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Paso 3: Salida de datos de Imprimir y Cortar

1. Imprima los datos de Imprimir y Cortar

Envíe los datos de impresión a la impresora e imprima los datos de Imprimir y Cortar.

Procedimiento

1. Cargue el material en la impresora.

Para saber cómo cargar el material en la impresora, consulte la documentación de la misma.

Si la impresión ampliada/reducida está activada, desactívela. Asegúrese de imprimir a escala 100 %.

IMPORTANTE

2. Oculte la capa que contiene las líneas de corte.

3. Haga clic en [File]>[Print].

4. Compruebe la configuración de impresión y haga clic en [Print].

Solo se imprimirán los datos de impresión.
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2. Cargue el material impreso

Cargue el material impreso desde una impresora a la máquina.

No se puede utilizar material enroscado, ya que las marcas de corte pueden no ser legibles. Si el material se curva al
imprimirlo, alíselo antes de cargarlo en la máquina.

IMPORTANTE

Procedimiento

1. Compruebe el origen del corte ( ) en el material.

2. Coloque el material situando su origen para el corte en la parte inferior izquierda de la máquina.

Si el material se carga en una dirección incorrecta, la máquina no podrá leer las marcas de corte.

IMPORTANTE

3. Coloque los rodillos de arrastre.

Tenga en cuenta los siguientes puntos al colocar los rodillos de arrastre.

• Colocar los rodillos de arrastre ( ) hacia el exterior de las marcas de la herramienta ( )

• Asegúrese de que los rodillos de arrastre ( ) están ajustados dentro del rango de los patrones
de presión ( )
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Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utili-
ce material en tamaños distintos a A3, A4 o B4.

• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al
menos 30 mm (W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia
despejada es inferior a 30 mm, la marca de corte no puede leerse.

NOTA

4. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

5. Levante la palanca de carga.
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El material está asegurado en su lugar.

6. Encienda la máquina.

7. Seleccione [PIEZA] como tipo de material.

8. Pulse [ENTER].

Se muestran el ancho y la longitud de corte.

W:***mm
L:***mm

9. Pulse [▲][▼] para mover el material y posicionar la marca de corte ( ) sobre el protector de la cuchilla
( ).

Las marcas de corte no pueden leerse en las situaciones indicadas a continuación. Retire el material una vez y
vuelva a cargarlo.

• Las marcas de corte están separadas del protector de la cuchilla ( ) por una distancia de 15 mm o más( )
• Las marcas de corte izquierda y derecha están inclinadas 5 grados o más ( ) con respecto a la dirección de

desplazamiento del carro de corte
• Las marcas de corte izquierda y derecha se desvían 20 mm o más ( ) en la dirección de avance del mate-

rial

IMPORTANTE
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10. Pulse [◀][▶] para mover el carro de corte de forma que la punta de la cuchilla pase por el centro de la
marca de corte inferior izquierda.
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Paso 4: Configure el ajuste para realizar la alineación automática

Coloque las marcas de corte automáticamente mediante el sensor integrado en la máquina.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<TOOL MODE>

3. Pulse [▶].

4. Pulse [▲] o [▼] para seleccionar "MODO SENSOR".

CROPMARK
 SENSOR MODE

5. Pulse [ENTER] para seleccionar el ajuste.

6. Pulse [MENU] para volver a la pantalla original.
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Paso 5: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. En el panel [Roland CutStudio], seleccione [GS2-24] en [Model].

3. En el panel, haga clic en [Update Information].

El rango de corte se adquiere de la máquina conectada, y la pantalla en [Media] se actualizará.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

4. Haga clic en  en la paleta, y luego haga clic en [Preferences].

5. Seleccione la casilla [Use Cut Setting].
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6. Haga clic en [OK].

7. Haga clic en  en la paleta, y luego haga clic en [Cut Setting].

[Cut Setting] se muestra seleccionando [Cut Setting].

8. Ajustar las condiciones de corte.

Normalmente, la casilla [Use Machine Setting] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use Machine Setting] e introduzca los
valores.

9. Haga clic en [OK].
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Se guardan el rango y las condiciones de corte.
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Paso 6: Cortando

Envíe los datos a la máquina y comience a cortar el material.

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Muestre la capa que contiene las líneas de corte y selecciónela.

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

2. Seleccione [Output Current Layer].

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

Para cambiar o comprobar la configuración de corte, consulte Paso 2: Ajuste de las condiciones de
corte.

3. En la paleta, haga clic en .

4. Seleccione [Roland GS2-24] y haga clic en [Cut].
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Los datos de corte se envían a la máquina. Cuando la máquina recibe los datos, lee automática-
mente las marcas de corte mediante un sensor y comienza a cortar.

Si el nombre del modelo no aparece, consulte La máquina no funciona.

NOTA

Si el sensor no lee las marcas de corte, aparece la pantalla que se muestra a continuación.

Si aparece la siguiente pantalla, consulte No se detectan las marcas de corte para resolver el error.

SET TO
<TOOL MODE>

Si esto no resuelve el problema, cambie al Tool Mode y realice la alineación 

P. 179Imprimir y Cortar en Tool Mode

NOTA

5. Una vez terminado el corte, haga clic en [Exit] para cerrar la ventana.

6. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material
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Esta sección describe cómo crear datos de corte con CorelDRAW y cómo realizar el corte.

Para dar salida a los datos de corte creados con CorelDRAW a CutStudio, es necesario instalar el comple-
mento de CutStudio para CorelDRAW.

Para obtener información sobre las últimas versiones compatibles, visite el sitio web de DGSHAPE Corpora-
tion (https://www.rolanddg.co.jp/).

 ENLACES RELACIONADOS 

・ GS2-24 Installation and Initial Settings Windows Version

Paso 1: Crear datos de corte

Introduzca texto y formas, y cree datos de corte. Esta sección explica cómo crear datos de corte utilizando
CorelDRAW 2020. El procedimiento de operación es el mismo para otras versiones.

Procedimiento

1. Inicie CorelDRAW.

2. En la barra de herramientas, haga clic en .

Aparece la paleta [Roland CutStudio].

3. Crea un nuevo documento.

Ajuste el tamaño del documento en uno de los tamaños de corte, que se muestran en la pantalla
del equipo después de configurar el material.

4. Introduzca texto y formas.

En este ejemplo, introducimos «SALE» y dibujamos una línea para rodear la palabra. Esta línea se
llama «línea de maleza» y se utiliza para facilitar la eliminación de los datos cortados.
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Contornear el texto. Al elegir el texto y hacer clic en  en la paleta [Roland CutStudio], el texto se con-
vierte en un contorno.

NOTA
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Paso 2: Salida de datos de corte a CutStudio

Envíe los datos de corte creados en CorelDRAW a CutStudio.

Procedimiento

1. Seleccione [Output All Lines] en la paleta [Roland CutStudio].

2. Seleccione la casilla [Auto Update].

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

3. Haga clic en .

Se inicia CutStudio y los datos de la línea de corte se envían a CutStudio.

Los datos de salida siempre se alinean en el origen de CutStudio independientemente de la posición en Corel-
DRAW.

NOTA
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Los datos creados en CorelDRAW se envían a CutStudio en las siguientes condiciones.

• Todos los gráficos que se dibujan se envían a CutStudio.
• Las cadenas de caracteres no se envían a CutStudio. Contornéelos antes de la salida.
• El ancho de línea, el relleno y las flechas se ignoran.
• Las líneas sin anchura no se imprimen.
• Las imágenes no se imprimen.

NOTA
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Paso 3: Ajuste de las condiciones de corte

Procedimiento

1. Compruebe que el material se ha cargado y colocado correctamente.

P. 27Preparación del material

2. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

3. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

4. Haga clic en [Change] bajo [Media Size].
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5. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

6. Haga clic en [OK].
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La configuración se guarda y aparece la ventana [Cutting Setup].

7. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

8. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA
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Paso 4: Cortando

Envía los datos de corte a la máquina y corta el material.

Si el material se desprende o la máquina funciona de forma anómala, pulse [PAUSE] para cancelar la salida.
Baje la palanca de carga, saque el material y vuelva a realizar la configuración desde el principio.

IMPORTANTE

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Comienza el corte.

 ENLACES RELACIONADOS 

・  P. 27 Preparación del material
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Comprobación de la ayuda de CorelDRAW

Procedimiento

1. En la barra de herramientas, haga clic en .

Aparece la paleta [Roland CutStudio].

2. En la paleta, haga clic en .

3. Haga clic en [Help].
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Paso 1: Ajuste las condiciones de impresión

Ajuste el rango de impresión para Imprimir y Cortar así como las marcas de corte.

Procedimiento

1. Inicie CorelDRAW y abra un nuevo documento.

Ajuste el tamaño del documento.

2. En la barra de herramientas, haga clic en .

Aparece la paleta [Roland CutStudio].

3. En la paleta, haga clic en .

Las marcas de corte se insertan en el documento.
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4. Haga clic en  en la paleta, y luego haga clic en [Crop-marks].

5. Ajuste el [Type], [Point].

Para [Type], seleccione «GS2-24».

[Point] indica el número de marcas de corte.

Cuando [Point] es «4» Marcas de corte: 4 puntos

Cuando [Point] es «3» Marcas de corte: 3 puntos
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Normalmente, seleccione «4» en [Point]. Cuando [Point] es «3», el Tool Mode no está disponible.

6. Ajuste el margen y la distancia entre las marcas de corte, y luego haga clic en [OK].

Para conocer los detalles sobre los márgenes y la distancia entre las marcas de corte, consulte la
tabla siguiente. Cuando utilice material con gran cantidad de avance (material largo), le recomen-
damos que ajuste los márgenes izquierdo y derecho a aproximadamente 25 mm.

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 4 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Márgenes y distancias entre marcas de corte en diferentes tamaños de material con 3 marcas de corte
(Unidad: mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si utiliza un material más grande que los tamaños indicados anteriormente, ajuste los valores consultando Los
márgenes y la distancia entre las marcas de corte(P. 344).

NOTA

Las marcas de corte se muestran en la mesa de trabajo.
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Paso 2: Crear datos de Imprimir y Cortar

1. Coloque los datos de impresión

Procedimiento

1. Haga clic en [File]>[Import] para importar los datos de impresión.

Aquí, Sample.bmp que se encuentra en la carpeta donde está instalado CutStudio (normalmente
situada en la carpeta [Program Files (x86)]>[CutStudio] de la unidad C) se abre como datos de
impresión.

2. Seleccione los datos de impresión y haga clic en [Import].

3. Coloque los datos de impresión en el área dentro de las marcas de corte.
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2. Añada líneas de corte a los datos de impresión

Añada líneas de corte a los datos de impresión posicionados y cree los datos de Imprimir y Cortar.

Procedimiento

1. Cree una nueva capa para las líneas de corte y dibuje allí las líneas de corte.

Aquí se dibuja una línea de corte alrededor de los datos de impresión, como se muestra a conti-
nuación ( ).

2. Haga clic en [File]>[Save].

3. Seleccione la carpeta en la que desea guardar los datos, introduzca el nombre del archivo y haga clic en
[Save].

Los datos de Imprimir y Cortar que ha creado se guardan.
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Paso 3: Salida de datos de Imprimir y Cortar

1. Imprima los datos de Imprimir y Cortar

Envíe los datos de impresión a la impresora e imprima los datos de Imprimir y Cortar.

Procedimiento

1. Cargue el material en la impresora.

Para saber cómo cargar el material en la impresora, consulte la documentación de la misma.

Si la impresión ampliada/reducida está activada, desactívela. Asegúrese de imprimir a escala 100 %.

IMPORTANTE

2. Oculte la capa que contiene las líneas de corte.

3. Haga clic en [File]>[Print].

4. Compruebe la configuración de impresión y haga clic en [Print].

Solo se imprimirán los datos de impresión.
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2. Cargue el material impreso

Cargue el material impreso desde una impresora a la máquina.

No se puede utilizar material enroscado, ya que las marcas de corte pueden no ser legibles. Si el material se curva al
imprimirlo, alíselo antes de cargarlo en la máquina.

IMPORTANTE

Procedimiento

1. Compruebe el origen del corte ( ) en el material.

2. Coloque el material situando su origen para el corte en la parte inferior izquierda de la máquina.

Si el material se carga en una dirección incorrecta, la máquina no podrá leer las marcas de corte.

IMPORTANTE

3. Coloque los rodillos de arrastre.

Tenga en cuenta los siguientes puntos al colocar los rodillos de arrastre.

• Colocar los rodillos de arrastre ( ) hacia el exterior de las marcas de la herramienta ( )

• Asegúrese de que los rodillos de arrastre ( ) están ajustados dentro del rango de los patrones
de presión ( )

Método de impresión y corte
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Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utili-
ce material en tamaños distintos a A3, A4 o B4.

• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al
menos 30 mm (W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia
despejada es inferior a 30 mm, la marca de corte no puede leerse.

NOTA

4. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

5. Levante la palanca de carga.

Método de impresión y corte
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El material está asegurado en su lugar.

6. Encienda la máquina.

7. Seleccione [PIEZA] como tipo de material.

8. Pulse [ENTER].

Se muestran el ancho y la longitud de corte.

W:***mm
L:***mm

9. Pulse [▲][▼] para mover el material y posicionar la marca de corte ( ) sobre el protector de la cuchilla
( ).

Las marcas de corte no pueden leerse en las situaciones indicadas a continuación. Retire el material una vez y
vuelva a cargarlo.

• Las marcas de corte están separadas del protector de la cuchilla ( ) por una distancia de 15 mm o más( )
• Las marcas de corte izquierda y derecha están inclinadas 5 grados o más ( ) con respecto a la dirección de

desplazamiento del carro de corte
• Las marcas de corte izquierda y derecha se desvían 20 mm o más ( ) en la dirección de avance del mate-

rial

IMPORTANTE

Método de impresión y corte
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10. Pulse [◀][▶] para mover el carro de corte de forma que la punta de la cuchilla pase por el centro de la
marca de corte inferior izquierda.

Método de impresión y corte
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Paso 4: Configure el ajuste para realizar la alineación automática

Coloque las marcas de corte automáticamente mediante el sensor integrado en la máquina.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<TOOL MODE>

3. Pulse [▶].

4. Pulse [▲] o [▼] para seleccionar "MODO SENSOR".

CROPMARK
 SENSOR MODE

5. Pulse [ENTER] para seleccionar el ajuste.

6. Pulse [MENU] para volver a la pantalla original.

Método de impresión y corte
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Paso 5: Envíe los datos de Imprimir y Cortar a CutStudio

Procedimiento

1. Muestre la capa que contiene las líneas de corte en CorelDRAW y selecciónela.

2. En la paleta [Roland CutStudio], seleccione [Output Current Layer] y luego haga clic en [Update].

Confirme que la línea de corte de salida se muestra en la pantalla de vista previa.

3. Haga clic en .

Se inicia CutStudio y los datos de la línea de corte se envían a CutStudio.

Método de impresión y corte
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Paso 6: Ajuste de las condiciones de corte

Procedimiento

1. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

2. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

3. Haga clic en [Change] bajo [Media Size].

Método de impresión y corte
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4. Haga clic en [Get from Machine].

Adquiera el rango de corte de la máquina conectada, y [Width] y [Length] en [Cutting Area] se
actualizarán.

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

5. Haga clic en [OK].

Método de impresión y corte
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La configuración se guarda y aparece la ventana [Cutting Setup].

6. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

7. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA

Método de impresión y corte
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Paso 7: Cortando

Envíe los datos de Imprimir y Cortar a la máquina y comience a cortar.

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. En CutStudio, haga clic en .

Aparece la ventana de [Cut].

2. Haga clic en [OK].

Los datos de Imprimir y Cortar se envían a la máquina. Cuando la máquina recibe los datos de Im-
primir y Cortar, lee automáticamente las marcas de corte mediante un sensor y, a continuación,
comienza a cortar.

Si el sensor no lee las marcas de corte, aparece la pantalla que se muestra a continuación.

Si aparece la siguiente pantalla, consulte No se detectan las marcas de corte(P. 298) para resolver el
error.

Si esto no resuelve el problema, cambie al Tool Mode y realice la alineación 

P. 179Imprimir y Cortar en Tool Mode

NOTA

Método de impresión y corte
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SET TO
<TOOL MODE>

3. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material

Método de impresión y corte
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Procedimientos después de
la salida

Descarga/corte de material ........................................................................ 174
Retirada del material .......................................................................... 174
Corte el material ............................................................................... 176

Pausa y cancelación de la salida ................................................................... 177
Pausa de impresión ............................................................................ 177
Cancelación de la impresión.................................................................. 177
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Después de la impresión, descargue o corte el material de la máquina.

Retirada del material

Una vez terminado el corte, retire el material.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [ENTER].

El carro de corte vuelve a la posición inicial.

3. Baje la palanca de carga.

No utilice una fuerza excesiva al mover la palanca de carga.
Si lo hiciera, podría dañarlo.

IMPORTANTE

4. Retire el material.

Descarga/corte de material
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Descarga/corte de material
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Corte el material

Después de la salida, corte el material según sea necesario.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

W:***mm
L:***mm

2. Pulse [▲][▼] para alimentar el material hasta que la línea de corte sobrepase la posición de la guía de la
cuchilla ( ).

3. Corte el material con una cuchilla, etc. a lo largo de la guía de la cuchilla en la superficie frontal de la
máquina.

Descarga/corte de material
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Pausa de impresión

Un proceso de corte en curso puede ser pausado, y la salida de corte pausada puede ser reanudada.

Esta operación puede comprometer la calidad del corte. Siempre que sea posible, evite las pausas.

NOTA

Procedimiento

1. Pulse [PAUSE] antes de finalizar la impresión.

Pausas de salida de corte.

2. Pulse [PAUSE] de nuevo.

La operación de impresión se reanuda.

Cancelación de la impresión

Realice la siguiente operación para terminar la salida de corte mientras el proceso de corte está en curso.

Esta operación cancela los datos de salida y no permite reanudar la salida cortada.

NOTA

Procedimiento

1. Pulse [PAUSE] antes de finalizar la impresión.

Pausas de salida de corte.

2. Mantenga pulsado [ENTER] durante un segundo o más.

Los datos de salida se cancelan. Inicie de nuevo la salida de corte.

Pausa y cancelación de la salida

Procedimientos después de la salida 177



Otro corte
Imprimir y Cortar en Tool Mode .................................................................... 179

Paso 1:  Establecer el método de alineación (Tool Mode) ............................... 179
Paso 2:  Corte después de la alineación automática...................................... 180

Imprimir y Cortar en modo manual ................................................................ 183
Paso 1:  Crear manualmente los datos de las marcas de herramientas................ 183
Paso 2:  Salida de datos de Imprimir y Cortar ............................................. 186
Paso 3:  Ajuste del método de alineación (modo manual)............................... 191
Paso 4:  Corte (modo manual)................................................................ 196

178  Otro corte



El Tool Mode puede utilizarse en las siguientes situaciones.

• Cuando no es posible realizar la alineación en el Sensor Mode

• Al realizar Imprimir y Cortar sin seleccionar el tipo de material

No es posible utilizar el Tool Mode cuando se utilizan solo 3 marcas de corte.

NOTA

Elementos necesarios

Herramienta de alineación
Material en el que se han impreso las marcas de las herra-

mientas ( )

Paso 1: Establecer el método de alineación (Tool Mode)

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<SENSOR MODE>

3. Pulse [▶].

CROPMARK
 SENSOR MODE

4. Pulse [▲] o [▼] para seleccionar "MODO HERRAMIEN".

CROPMARK
 TOOL MODE

5. Pulse [ENTER].

CROPMARK
<TOOL MODE>

6. Pulse [MENU] para volver a la pantalla original.

Imprimir y Cortar en Tool Mode
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Paso 2: Corte después de la alineación automática

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Cuando [File]>[Print&Cut] de CutStudio no esté seleccionado, selecciónelo.

2. Enviar datos de corte.

Aparece la siguiente pantalla.

REPLACE TO TOOL
(QUIT   MENU)

3. Retire el soporte de la cuchilla e instale la herramienta de alineación.

La herramienta de alineación puede instalarse de la misma manera que el soporte de la cuchilla.

4. Pulse [ENTER].

Aparece la siguiente pantalla.

Imprimir y Cortar en Tool Mode
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MARK1 SET
(RETURN MENU)

5. Pulse [▲][▼][◀][▶] y alinee la punta de la herramienta de alineación con la marca de la herramienta 1.

Mantenga la herramienta de alineación suavemente desde arriba con el dedo y compruebe que la
punta de la herramienta de alineación se superpone a la marca de la herramienta.

6. Pulse [ENTER].

La herramienta se desplaza a una posición cercana a la marca de corte inferior derecha, y aparece
la pantalla que se muestra a continuación.

MARK2 SET
(RETURN MENU)

7. Pulse [▲][▼][◀][▶] y alinee la punta de la herramienta de alineación con la marca de la herramienta 2.

Para volver a realizar la alineación, pulse [MENU] durante la configuración para volver a la pantalla anterior y
realice el procedimiento de nuevo.

NOTA

8. Pulse [ENTER].

La herramienta se desplaza a una posición cercana a la marca de corte superior izquierda, y apare-
ce la pantalla que se muestra a continuación.

MARK3 SET
(RETURN MENU)

9. Alinee las marcas de herramienta 3 y 4 de la misma manera.

Marca de herramienta 3 Marca de herramienta 4
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10. Después de alinear la marca de la herramienta 4, pulse [ENTER].

Aparece la siguiente pantalla.

REPLACE TO BLADE
(RETURN MENU)

11. Retire la herramienta de alineación e instale el soporte de la cuchilla.

12. Pulse [ENTER].

13. Pulse [ENTER] cuando aparezca la siguiente pantalla.

Comienza el corte.

COMPLETE ENTER
QUIT    MENU

14. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 43 Instale el soporte de la cuchilla

・  P. 174 Retirada del material
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Utilizando el modo manual, puede realizar Imprimir y Cortar sin utilizar CutStudio, Adobe Illustrator o Co-
relDRAW.

Compruebe previamente el material compatible y la impresora que va a utilizar.

Impresora a utilizar

Impresora láser o de inyección de tinta con una resolución de 720 dpi o superior

 ENLACES RELACIONADOS 

・  P. 15 Condiciones de los materiales utilizables

Paso 1: Crear manualmente los datos de las marcas de herramientas

Cree datos de marcas de herramientas utilizando un software distinto de CutStudio, Adobe Illustrator o Co-
relDRAW.

Cuando utilice un software de aplicación para añadir marcas de herramienta a una ilustración, ajuste la
posición teniendo en cuenta el margen necesario para el corte.
Esta sección describe cómo crear manualmente los datos de las marcas de las herramientas utilizando da-
tos de muestra.

Datos de muestra:

Sample.bmp que se encuentra en la carpeta de instalación de CutStudio (normalmente situada en la
carpeta [Program Files (x86)]>[CutStudio] de la unidad C)

Procedimiento

1. Dibujar marcas de herramientas.

No hay un diseño concreto que deba utilizarse para las marcas de herramientas, pero el uso de for-
mas con esquinas, como se muestra en la figura siguiente, facilita la alineación.

El punto de origen del corte está en la parte inferior izquierda. La marca de la herramienta de ori-
gen debe ser reconocible entre otras marcas de herramientas.

2. Configurar los márgenes.

Cuando utilice material con una gran cantidad de avance (material largo), se recomienda ajustar
los siguientes márgenes: aproximadamente 25 mm ( ) a la izquierda y a la derecha respectiva-
mente, aproximadamente 20 mm ( ) en la parte superior en la dirección de avance del material,
y aproximadamente 50 mm ( ) en la parte posterior en la dirección de avance.

Imprimir y Cortar en modo manual
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3. Anote la distancia entre las marcas de la herramienta (ancho como W, longitud como L).

4. Anote los valores de desplazamiento.

Compruebe el origen (donde tanto X como Y son 0) del software, y anote la distancia entre este
punto de origen ( ) y la marca de la herramienta inferior izquierda (W, L).

5. Coloque la ilustración dentro del área de corte definida por las marcas de la herramienta.

Imprimir y Cortar en modo manual
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 ENLACES RELACIONADOS 

・  P. 344 Los márgenes y la distancia entre las marcas de corte
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Paso 2: Salida de datos de Imprimir y Cortar

1. Imprima los datos de Imprimir y Cortar

Procedimiento

1. Cargue el material de lámina en la impresora.

Para saber cómo cargar el material en la impresora, consulte la documentación de la misma.

Si la impresión ampliada/reducida está activada, desactívela. Asegúrese de imprimir a escala 100 %.

IMPORTANTE

2. Imprima los datos de Imprimir y Cortar.

Imprimir y Cortar en modo manual
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2. Cargue el material impreso

Cargue el material impreso desde una impresora a la máquina.

El material a veces se riza cuando se imprime desde la impresora. Aplane el material rizado antes de cargarlo en la
máquina.

IMPORTANTE

Procedimiento

1. Compruebe el origen ( ) para cortar el material.

2. Ajuste el origen para el corte en la esquina inferior izquierda del material y, a continuación, cargue el
material en el equipo.

Si el material se carga en la dirección incorrecta, los valores indicados en los procedimientos 3 y 4 del paso 1
no serán válidos, y el corte no podrá realizarse correctamente.

IMPORTANTE

3. Coloque los rodillos de arrastre.

Tenga en cuenta los siguientes puntos al colocar los rodillos de arrastre.

• Colocar los rodillos de arrastre ( ) hacia el exterior de las marcas de la herramienta ( ).

• Asegúrese de que un rodillo de arrastre ( ) está ajustado dentro del rango del patrón de grano
( ).
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4. Alinee el borde izquierdo del material de manera que quede aproximadamente paralelo a la línea guía
( ).

Vista desde arriba de la máquina

5. Levante la palanca de carga para fijar el material en su lugar.

6. Encienda la máquina.

7. Seleccione [PIEZA] como tipo de material.

8. Pulse [ENTER].

Se muestran la anchura y la longitud de corte.

W:***mm
L:***mm

Imprimir y Cortar en modo manual

188  Otro corte



9. Pulse [▲][▼] para mover el material y posicionar la marca de la herramienta ( ) sobre el protector de la
cuchilla ( ).

Si se produce alguna de las siguientes situaciones, retire el material una vez y vuelva a cargarlo.

• Las marcas de la herramienta están separadas del protector de la cuchilla por 15 mm o más
• Las marcas de la herramienta derecha e izquierda están inclinadas 5 grados o más con respecto a la direc-

ción de desplazamiento del carro de corte
• Se desvía 20 mm o más en la dirección de avance del material

IMPORTANTE

10. Pulse [◀][▶] para desplazar el carro de corte de forma que la punta de la cuchilla sobrepase la marca de
la herramienta inferior izquierda.

Imprimir y Cortar en modo manual
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Paso 3: Ajuste del método de alineación (modo manual)

1. Seleccione el modo manual

Ajuste el método de alineación de las marcas de corte en modo manual.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CROPMARK
<SENSOR MODE>

3. Pulse [▶].

CROPMARK
 SENSOR MODE

4. Pulse [▲][▼] y seleccione "MANUAL".

CROPMARK
 MANUAL

5. Pulse [ENTER].

CROPMARK
<MANUAL>

6. Pulse [▶].
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2. Introduzca la distancia entre las marcas de la herramienta

Introduzca la distancia, la anchura (W) y la longitud (L), que se anotó cuando se crearon manualmente las
marcas de la herramienta.

Procedimiento

1. Pulse [▶] tres veces para visualizar la pantalla que se muestra a continuación.

WIDTH 160
*160mm

2. Pulse [▲][▼] e introduzca la distancia horizontal ("ANCHO") entre las marcas de la herramienta.

WIDTH 160
*180mm

3. Pulse [ENTER] para seleccionar el ajuste.

WIDTH 180

4. Pulse [▼], y a continuación [▶] para visualizar la pantalla que se muestra a continuación.

LENGTH 210
*210mm

5. Pulse [▲][▼] e introduzca la distancia vertical ("LARGO") entre las marcas de la herramienta.

LENGTH 210
*230mm

6. Pulse [ENTER] para seleccionar el ajuste.

LENGTH 230

Imprimir y Cortar en modo manual
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 ENLACES RELACIONADOS 

・  P. 183 Crear manualmente los datos de las marcas de herramientas
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3. Introduzca los valores de desplazamiento

Introduzca la distancia del valor de desplazamiento, la anchura (W) y la longitud (L), que se anotó cuando
se crearon manualmente las marcas de la herramienta.

Procedimiento

1. Pulse [▼], y a continuación [▶] para visualizar la pantalla que se muestra a continuación.

OFFSET W 0.5
*0.5mm

2. Introduzca el valor de desplazamiento de la anchura (W) con [▲][▼].

OFFSET W 0.5
*0.0mm

3. Pulse [ENTER] para seleccionar el ajuste.

OFFSET W 0.0

4. Pulse [▼], y a continuación [▶] para visualizar la pantalla que se muestra a continuación.

OFFSET L 0.5
*0.5mm

5. Introduzca el valor de desplazamiento de longitud (L) con [▲][▼].

OFFSET L 0.5
*0.0mm

6. Pulse [ENTER] para seleccionar el ajuste.

OFFSET L 0.0
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 ENLACES RELACIONADOS 

・  P. 183 Crear manualmente los datos de las marcas de herramientas
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Paso 4: Corte (modo manual)

No toque nunca el carro de corte mientras la salida esté en curso.
El carro de corte se mueve a gran velocidad. El contacto con el carro en movimiento puede provocar lesiones.

ADVERTENCIA

Procedimiento

1. Pulse [◀], y a continuación [▼] para visualizar la pantalla que se muestra a continuación.

Para las 3 marcas de la herramienta, seleccione "ARRANCA 3 PUNT".

MANUAL
4-POINT START

2. Pulse [ENTER].

Aparece la siguiente pantalla.

REPLACE TO TOOL
(QUIT   MENU)

3. Retire el soporte de la cuchilla e instale la herramienta de alineación.

La herramienta de alineación puede instalarse de la misma manera que el soporte de la cuchilla.

4. Pulse [ENTER].

Aparece la siguiente pantalla.

MARK1 SET
(RETURN MENU)

5. Pulse [▲][▼][◀][▶] y alinee la punta de la herramienta de alineación con la marca de la herramienta 1.

Mantenga la herramienta de alineación suavemente desde arriba con el dedo y compruebe que la
punta de la herramienta de alineación se superpone a la marca de la herramienta.

Imprimir y Cortar en modo manual
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6. Pulse [ENTER].

La herramienta se desplaza a una posición cercana a la marca inferior derecha de la herramienta,
y luego aparece la pantalla que se muestra a continuación.

MARK2 SET
(RETURN MENU)

7. Pulse [▲][▼][◀][▶] y alinee la punta de la herramienta de alineación con la marca de la herramienta 2.

Para volver a realizar la alineación, pulse [MENU] durante la configuración para volver a la pantalla anterior y
realice el procedimiento de nuevo.

NOTA

8. Pulse [ENTER].

La herramienta se desplaza a una posición cercana a la marca superior izquierda de la herramienta
y luego aparece la pantalla que se muestra a continuación.

MARK3 SET
(RETURN MENU)

9. Alinee las marcas de herramienta 3 y 4 de la misma manera.
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10. Después de alinear la marca de la herramienta 4, pulse [ENTER].

Aparece la siguiente pantalla.

REPLACE TO BLADE
(RETURN MENU)

11. Retire la herramienta de alineación e instale el soporte de la cuchilla.

12. Pulse [ENTER].

13. Pulse [ENTER] cuando aparezca la siguiente pantalla.

COMPLETE ENTER
QUIT    MENU

14. Cuando aparezca la pantalla que se muestra a continuación, envíe los datos de corte desde el ordenador.

OUTPUT DATA

Cuando la máquina recibe los datos, comienza a cortar.

15. Retire el material cortado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material

・  P. 43 Instale el soporte de la cuchilla
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Guía general sobre las condiciones de corte

Las tres condiciones de corte son la fuerza de la cuchilla, la velocidad de corte y el desplazamiento de la
punta de la cuchilla.

A continuación se ofrece una guía general sobre las condiciones de corte y la vida útil de la cuchilla para
diferentes combinaciones de materiales y cuchillas.

Hay que tener en cuenta que el corte óptimo no se obtiene necesariamente por el simple hecho de cumplir
con las condiciones siguientes. Antes de cortar, asegúrese de realizar una prueba de corte con una cuchilla
adecuada para el material de lámina.

Ciertas cuchillas son adecuadas para ciertos materiales de lámina. El corte de materiales no especificados como ade-
cuados puede provocar la rotura de la cuchilla.

IMPORTANTE

Cuchilla Material Fuerza de corte
(gf)

Velocidad de
corte (cm/seg)*1

Desplazamiento
de la punta de

la cuchilla (mm)

Vida útil (m) *2

ZEC-U5032 Vinilo de señalización general 30 a 100 20 o menos 0,25 4,000

ZEC-U5025
Vinilo de señalización general 40 a 100 20 o menos

0,25
4,000

Vinilo Fluorescente 120 a 200 10 o menos 2,500

 

*1 Cuanto más rápida sea la velocidad de corte, peor será la calidad de la imagen. Ajusta la velocidad a la calidad de imagen
deseada.

*2 La vida útil es una guía general en el caso de que se haya cortado el mismo tipo de materiales.
 

Cuando queden áreas sin cortar, incluso cuando la fuerza de la cuchilla se incremente a un valor superior a los valores
mostrados en esta tabla en 50 a 60 gf, sustituya la cuchilla.

NOTA

 ENLACES RELACIONADOS 

・  P. 45 Realizar corte de prueba

・  P. 202 Ajuste de la configuración de corte

・  P. 288 Sustituir la cuchilla

Condición de corte
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Realice una prueba de corte antes de ajustar la configuración de corte. Ajuste la condición de corte des-
pués de comprobar el resultado de la prueba de corte. Puede cambiar la fuerza de la cuchilla, la velocidad
de corte y el desplazamiento de la punta de la cuchilla desde la ventana del controlador de la impresora
[Print Setting] (o CutStudio/VersaWorks).

 ENLACES RELACIONADOS 

・  P. 45 Realizar corte de prueba

Ajustar la profundidad de corte

Cuando desee realizar un ajuste preciso y fino de la cantidad de corte, como cuando se corta material con
papel de soporte fino, puede obtener buenos resultados ajustando la cantidad de extensión de la cuchilla.
Gire la parte de la tapa del soporte de la cuchilla para ajustar la extensión de la cuchilla.

La extensión de la cuchilla ( ) es de 0 mm ( ) como mínimo y de 2,5 mm ( ) como máximo. Se puede
realizar un ajuste de 0,5 mm girando el tapón una vuelta completa.

Ajuste la extensión de la cuchilla ( ) a una cantidad que sea la suma del grosor de la parte del material
( ) y la mitad ( ) del papel de soporte ( ).

Si va a cortar líneas perforadas en material sin papel de soporte, ajuste la cantidad de extensión de la cuchilla( ) de
manera que cuando el cortador perfore el material ( ), la cuchilla se extienda ligeramente. Empujar la cuchilla dema-
siado lejos dañará la cuchilla y el protector de la cuchilla y acelerará su deterioro, así que tenga cuidado.

NOTA

Ajuste de la configuración de corte
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Ajuste la fuerza de la cuchilla

Si el diseño se despega o si el papel de soporte se corta también con el material, cambie la fuerza de la
cuchilla.

Procedimiento

1. Compruebe que el deslizador PEN FORCE [PEN FORCE] está en la posición central (en «0» en la escala).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Pulse [FORCE].

Se muestra la fuerza actual de la cuchilla.

FORCE 50gf
* 50gf

3. Pulse [▲] o [▼] para seleccionar un valor.

4. Pulse [ENTER] para seleccionar el ajuste.

• Ajuste predeterminado de fábrica: 50 gf
• Rango de ajuste: 30 a 500 gf (se puede cambiar en pasos de 10 gf)

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

Ajuste de la fuerza de la cuchilla

Después de ajustar la fuerza de la cuchilla mediante el menú "PRESION", puede ajustar aún más la fuerza
de la cuchilla mediante el deslizador PEN FORCE. "PRESION"Utilice esta operación cuando desee hacer que
la fuerza de la cuchilla sea ligeramente mayor o menor que el ajuste realizado mediante el menú.

Procedimiento

1. Ajuste la fuerza de la cuchilla con el deslizador PEN FORCE.

Ajuste de la configuración de corte
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▲
▲ ▲▲

-2 -1 0 +1 +2

• Rango ajustable: ±Aproximadamente 30 gf

El valor ajustado aquí es solo una guía aproximada. La exactitud de este valor no está garantizada.

NOTA

Ajuste de la configuración de corte
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Ajuste de la velocidad de corte

Ajuste la velocidad de corte.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse [▶].

3. Pulse [▲][▼] para que aparezca la siguiente pantalla.

SPEED 40cm/s

4. Pulse [▶].

5. Pulse [▲] o [▼] para seleccionar un valor.

SPEED 40cm/s
  10cm/s

6. Pulse [ENTER] para seleccionar el ajuste.

7. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: 20 cm/s
• Rango de ajuste: de 1 a 85 cm/s (pasos de 1 cm/s)

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

Ajuste de la configuración de corte
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Ajuste del desplazamiento de la punta de la cuchilla

Este ajuste permite establecer el desplazamiento de la punta de la cuchilla. Inserte el valor mostrado de
desplazamiento de la cuchilla. Si se utiliza la cuchilla incluida, el corte puede realizarse con los ajustes
predeterminados de fábrica.

Si el inicio de un corte se desvía de la ubicación prevista o si las esquinas de una forma no están limpias, ajuste el valor
de desplazamiento.

NOTA

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse [▶].

3. Pulse [▲][▼] para que aparezca la siguiente pantalla.

OFFSET 0.250mm

4. Pulse [▶].

5. Pulse [▲] o [▼] para seleccionar un valor.

OFFSET 0.250mm
  0.500mm

6. Pulse [ENTER] para seleccionar el ajuste.

7. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: 0,250 mm
• Rango de ajuste: 0,000 a 1,000 mm (en pasos de 0,025 mm)

NOTA

 ENLACES RELACIONADOS 
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・  P. 201 Guía general sobre las condiciones de corte
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Establecer la orientación de las coordenadas de corte

Gire las coordenadas de corte y decida en qué dirección cortar el material.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse [▶].

3. Pulse [▲][▼] para que aparezca la siguiente pantalla.

ROTATE 0deg A

4. Pulse [▶].

5. Pulse [▲] o [▼] para seleccionar un ajuste.

ROTATE 0deg A
*0deg A

"0deg" Las flechas de las figuras siguientes indican las direcciones
positivas de los ejes X e Y, respectivamente.

• Punto de origen: Abajo a la izquier-
da

• Eje de coordenadas:
Dirección vertical: Eje Y
Dirección horizontal: Eje X

Ajuste de la configuración de corte
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"90deg" Las flechas de las figuras siguientes indican las direcciones
positivas de los ejes X e Y, respectivamente.

• Punto de origen: Abajo a la derecha
• Eje de coordenadas:

Dirección vertical: Eje X
Dirección horizontal: Eje Y

6. Pulse [ENTER] para seleccionar el ajuste.

• Ajuste predeterminado de fábrica: "0deg"

NOTA

También puede confirmar el valor de ajuste pulsando varias veces MENU para que aparezca la si-
guiente pantalla.

• Cuando se ajusta a "0deg"

20cm/s
250gf 0.250mm ∠A

• Cuando se ajusta a "90deg"

20cm/s
250gf 0.250mm ∠ A

7. Pulse [MENU] para volver a la pantalla original.

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

Ajuste de la configuración de corte
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Ampliación del área de corte

La ampliación de la zona de corte permite aprovechar al máximo el material.

Dependiendo del diseño a cortar, los rodillos de arrastre pueden pasar por encima de la línea de corte.

NOTA

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse [▶].

3. Pulse [▲][▼] para que aparezca la siguiente pantalla.

EXTEND 0.0mm

4. Pulse [▶].

5. Pulse [▲] o [▼] para seleccionar un valor.

EXTEND 0.0mm
  10.0mm

• El valor ajustado se aplica a ambos extremos del área de corte.
• Si "EXTENDER" se ajusta después de cargar el material, el valor "W" que se muestra en el panel de operacio-

nes diferirá de la anchura de corte real.

IMPORTANTE

Ajuste de la configuración de corte
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Ejemplo: Cuando se ajusta de 0 mm a 10,0 mm

200 mm

220 mm

10 mm

6. Pulse [ENTER] para seleccionar el ajuste.

7. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: 0,0 mm
• Rango de ajuste: 0,0 a 10,0 mm

NOTA

 ENLACES RELACIONADOS 

・  P. 39 Seleccione el tipo de material

Ajuste de la configuración de corte
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Ajuste de la velocidad de la cuchilla durante el corte

Este ajuste le permite establecer la velocidad para mover la cuchilla a la siguiente posición de corte con la
cuchilla levantada del material durante la operación de corte. Cuando se corta un material más fino o más
grueso que el material estándar, puede ser mejor disminuir la velocidad para evitar problemas como que el
material se levante.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, siga el siguiente procedimiento para visualizar la pantalla.
1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼].

NOTA

2. Pulse [▶].

3. Pulse [▲][▼] para que aparezca la siguiente pantalla.

UPSPEED 40cm/

4. Pulse [▶].

5. Pulse [▲] o [▼] para seleccionar un valor.

UPSPEED 40cm/
  AUTO

Cuando "AUTO" está configurado, se mueve a la velocidad establecida en "VELOC.". El aumento de
"UPSPEED" acorta el tiempo de corte.

6. Pulse [ENTER] para seleccionar el ajuste.

7. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "AUTO"
• Rango de ajuste: de 10 a 85 cm/s (pasos de 5 cm/s), "AUTO"

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte
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Suavizar los arcos de corte y otras curvas (suavizar)

Puede ajustar las curvas en los datos de corte enviados a esta máquina para suavizarlos. Normalmente, la
palanca de ajuste de altura se sitúa en "ON". Si los cortes de las esquinas son demasiado redondos al cortar
textos pequeños o formas intrincadas, ajústelo a "OFF". Le recomendamos que también lo configure en
"OFF" cuando necesite aumentar la productividad sin importar la calidad.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

SMOOTHING ON

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar "ON" o "OFF".

SMOOTHING ON
*ON

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "ON"

NOTA

Ajuste de la configuración de corte
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Cortar en la misma posición repetidamente (solapamiento)

El corte se repite varias veces en la misma posición con los mismos datos de corte. Utilice este ajuste para
los materiales que no pueden cortarse de una sola pasada, como los materiales gruesos.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

OVERLAP OFF

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar un valor.

OVERLAP OFF
*OFF

Además del corte normal, el corte se realiza un número de veces igual al valor establecido.

NOTA

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "OFF"
• Rango de ajuste: "OFF", 1 a 10

NOTA
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 ENLACES RELACIONADOS 

・  P. 81 Cortando

Ajuste de la configuración de corte
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Cortar las esquinas limpiamente (sobrecorte)

Esta función recorta un extra al principio y al final de una línea de corte. Es eficaz cuando se desea produ-
cir esquinas especialmente afiladas, por ejemplo al cortar materiales más gruesos. Cuando se cortan ca-
racteres pequeños o formas complejas, esta función se ajusta normalmente a "OFF" para evitar cortar par-
tes necesarias del material.

"ON" "OFF"

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

OVER CUT OFF

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar "ON" o "OFF".
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OVER CUT OFF
*OFF

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "OFF"

NOTA

Ajuste de la configuración de corte
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Utilice un material más fino o más duro de lo normal

Encienda el ventilador de succión para mantener el material en su lugar durante el corte para evitar que
el material se levante o se mueva de su lugar. Normalmente se utiliza "AUTO" tal cual. Sin embargo, el
volumen de aire del ventilador de succión debe reducirse cuando se utilicen materiales finos y/o poco fir-
mes.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

VACUUMFAN AUTO

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar un valor.

Utilice un volumen de aire más débil cuando utilice material fino.

VACUUMFAN AUTO
*AUTO

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "AUTO"

NOTA
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• Rango de ajuste: 1 a 5, "AUTO"

Prevención y corrección de cortes desalineados
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Cómo evitar el corte desalineado

El material se alimenta automáticamente antes y durante el corte para evitar la desalineación de las posi-
ciones de corte. Si se ajusta como "ON", el material avanza automáticamente 1 m cada vez que el ordena-
dor envía datos de corte (dependiendo de los datos, el material puede avanzar 1 m o más), y luego se ini-
cia el corte.

Si el material ya ha sido alimentado utilizando la función "AREA", el material no se alimentará automáticamente por la
cantidad que ya ha sido alimentada, incluso si "ALIMENTAC" se ajusta a "ON".

NOTA

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

PRE-FEED OFF

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar "ON" o "OFF".

PRE-FEED OFF
*OFF

7. Pulse [ENTER] para seleccionar el ajuste.

8. Cuando se selecciona "ON", ajuste la velocidad de alimentación del material.

(1) Pulse [▶] dos veces para visualizar la pantalla que se muestra a continuación.
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SPEED 40cm/s

(2) Pulse [▶].

(3) Pulse [▲] o [▼] para seleccionar un valor.

(4) Pulse [ENTER] para seleccionar el ajuste.

9. Pulse [MENU] para volver a la pantalla original.

• Ajuste predeterminado de fábrica: "OFF"
• Rango de ajuste: "ON" (1 a 10 cm/s), "OFF"

NOTA
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Ajustar la posición de corte

Si la posición de impresión y la posición de corte están desplazadas como se muestra en la siguiente figura,
puede corregir el problema ajustando la posición de impresión o la posición de corte. Este ejemplo mues-
tra el procedimiento para ajustar la posición de corte.

: Línea de corte prevista

: Línea de corte real

Procedimiento

1. Compruebe que el material se ha cargado.

2. Compruebe los valores de corrección en función del estado de corte.

"CROP-L" indica la dirección de avance del material y "CROP-W" indica la dirección de movimiento
del carro de corte.

Ejemplo: Para desplazar la línea de corte 0,5 mm hacia la derecha ( ) y 0,7 mm hacia arriba ( )

+

+
-

-

• CROP-W: Ajustado a +0,500

• CROP-L: Ajustado a +0,700

3. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

4. Pulse [▼] para que aparezca la siguiente pantalla.
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OTHERS

5. Pulse [▶].

6. Pulse [▲][▼] para que aparezca la siguiente pantalla.

CROP ADJ.

7. Ajuste los valores de corrección para CROP-L y CROP-W.

(1) Pulse [▶] dos veces para visualizar la pantalla que se muestra a continuación.

CROP-L 0.000
*0.000mm

(2) Pulse [▲][▼] para ajustar el valor de corrección de CROP-L.

(3) Pulse [ENTER] para seleccionar el ajuste.

(4) Pulse "▼", y a continuación "▶" para visualizar la pantalla que se muestra a continuación.

CROP-W 0.000
*0.000mm

(5) Pulse [▲][▼] para ajustar el valor de corrección de CROP-W.

(6) Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

9. Vuelva a realizar el corte.

Si se corrige la desalineación de la línea de corte, el ajuste está completo. Si es necesario un ma-
yor ajuste, repita el proceso.

NOTA
• Ajuste predeterminado de fábrica:

"CROP-L": (Dirección de avance del material) 0,000

"CROP-W": (Dirección de desplazamiento del carro de corte) 0,000

• Rango de ajuste: de -25,000 mm a +25,000 mm
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Ajustar la posición de impresión

Si la posición de impresión y la posición de corte están desplazadas como se muestra en la siguiente figura,
puede corregir el problema ajustando la posición de impresión o la posición de corte. Este ejemplo mues-
tra el procedimiento para ajustar la posición de impresión.

: Línea de corte prevista

: Línea de corte real

Procedimiento

1. En CutStudio, haga clic en [File]>[Printing Setup].

Prevención y corrección de cortes desalineados
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2. Seleccione [Fine adjustment] y haga clic en [Adjust].

Aparece la ventana [Crop Mark Adjustment].

3. Alinee la posición con respecto a una línea o punto ( ) que esté cerca del origen ( ).

Ajuste los valores de [BaseX] y [BaseY] para eliminar la desalineación y luego haga clic en [OK].

• Cuando la posición de corte se desvía a la izquierda o a la derecha de la posición de impre-
sión

Cambia el valor de [BaseX]. Si la posición de corte está desplazada a la derecha de la posición
de impresión, aumente el valor; si está desplazada a la izquierda de la posición de impresión,
disminuya el valor. En el caso que se muestra en la figura anterior, aumenta [BaseX].

• Cuando la posición de corte se desvía por encima o por debajo de la posición de impresión

Cambia el valor de [BaseY]. Si la posición de corte está desplazada por encima de la posición
de impresión, aumente el valor; si está desplazada por debajo de la posición de impresión, dis-
minuya el valor. En el caso que se muestra en la figura anterior, aumenta [BaseY].

Si las posiciones de impresión y corte están desalineadas en un lugar distante del origen ( )
como se muestra en la siguiente figura, incluso después de ajustar las posiciones con [BaseX] y
[BaseY], el material expandido, contraído o distorsionado puede estar causando que la distan-
cia entre las marcas de corte impresas se desvíe del ajuste ([W], [L]). Proceder al paso 4.

4. Ajuste [W] y [L] en la ventana [Crop Mark Adjustment], y corrija las diferencias.

Sin embargo, los valores son meramente orientativos. Los valores óptimos deben encontrarse cam-
biando los valores y cortando realmente el material varias veces.

Prevención y corrección de cortes desalineados
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Antes de ajustar, compruebe que [BaseX] y [BaseY] se han ajustado con respecto a una línea o punto cercano
al origen ( ). Si se alinea con respecto a un punto lejano, el resultado del ajuste del paso 3 se desviará cuan-
do se ajusten [W] y [L].

IMPORTANTE

• Las líneas de corte se desvían hacia fuera de la posición de impresión

Esto puede deberse a que la distancia entre las marcas de corte impresas es mayor que el ajus-
te. En este caso, ajuste [W] y [L] mayores que los valores para ajustar el posicionamiento.

• Las líneas de corte se desvían hacia el interior de la posición de impresión

Esto puede deberse a que la distancia entre las marcas de corte impresas es más corta que el
ajuste. En este caso, ajuste [W] y [L] menores que los ajustes para ajustar el posicionamiento.

: Punto de origen

Los valores introducidos en la ventana [Crop Mark Adjustment] solo son efectivos cuando se selecciona
[Adjust] en el cuadro de diálogo [Printing Setup]. Todos los valores introducidos se borran si se deselec-
ciona [Fine adjustment] o cuando se modifican los ajustes [W] y [L] de [CROPMARK].

IMPORTANTE

Si el sensor no lee las marcas de corte, aparece la pantalla que se muestra a continuación.

Si aparece la siguiente pantalla, consulte No se detectan las marcas de corte(P. 298) para resolver el
error.

SET TO
<TOOL MODE>

NOTA

Prevención y corrección de cortes desalineados
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Si esto no resuelve el problema, cambie al Tool Mode y realice la alineación 

P. 179Imprimir y Cortar en Tool Mode

Prevención y corrección de cortes desalineados
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"REPLOTEAR"

Los datos recibidos del ordenador pueden guardarse en la memoria de la máquina y esos datos pueden uti-
lizarse repetidamente para cortar (recortar). Para volver a cortar, utilice "REPLOTEAR" en el menú de la
pantalla.

• Se guardan todos los datos recibidos desde el momento en que la máquina se pone en la condición de
preparación hasta el momento en que se cancela la condición de preparación.

• Los datos no se borran aunque se cancele la condición de configuración.

• Si se cancela la condición de configuración y se vuelve a poner la máquina en la condición de configu-
ración, cualquier dato que se haya guardado se sobrescribe con los nuevos datos que se envían desde
el ordenador.

• Todos los datos se borran cuando se desconecta la alimentación.

• Si los datos almacenados en la memoria de la máquina superan los 2 MB, no se podrá realizar el recor-
tado hasta que se borren los datos. Si se realiza "REPLOTEAR" en estas condiciones, aparece "SATURA-
CION DATOS". Si no hay datos almacenados en la memoria de la máquina, aparece "SIN DATOS" cuando
se selecciona "REPLOTEAR" en el menú.

Paso 1: Preparar los datos para el corte

Borre todos los datos que queden en la memoria de la máquina y, a continuación, envíe nuevos datos para
que solo se almacenen en la memoria de la máquina los datos necesarios.

Procedimiento

1. Compruebe que el material se ha cargado.

2. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

3. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

REPLOT
<DATA EXISTS>

Si aparece "SIN DATOS", vaya al paso 6.

4. Pulse [▶].

REPLOT
*START

5. Pulse [▼] para seleccionar "LIMPIAR".

REPLOT
*CLEAR

6. Pulse [ENTER].

Cortar los mismos datos repetidamente
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Los datos se borran.

REPLOT
<NO DATA>

7. Enviar datos desde el ordenador.

Cortar los mismos datos repetidamente
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Paso 2: Recortando

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

UNSETUP

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

REPLOT
<DATA EXISTS>

3. Pulse [▶].

REPLOT
*START

4. Pulse [ENTER].

La pantalla vuelve a ser la que se muestra a continuación y se realiza el corte que se ha guardado
en la memoria.

20cm/s
250gf 0.250mm ∠A

Cortar los mismos datos repetidamente
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Guardar las condiciones de corte

Para ahorrar tiempo en la configuración de las condiciones de corte para cada cambio de material, puede
guardar en la memoria las condiciones de corte de los materiales más utilizados. La próxima vez que utili-
ce el mismo material, podrá cambiar los ajustes a los adecuados para el material simplemente cargando la
memoria previamente guardada.

Se pueden guardar ocho conjuntos de ajustes en las memorias USER 1 a USER 8. Al sobrescribir una memo-
ria se borran las condiciones de corte antiguas que contiene.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

MEMORY
<USER1>

3. Pulse [▶], [▼] y luego [▶].

SAVE USER1
50-20-0.250

La pantalla muestra los valores de los menús "PRESION","VELOC." y "OFFSET" desde la izquierda.

4. Pulse [▲][▼] para seleccionar el número de memoria en el que desea guardar las condiciones de corte.

5. Pulse [ENTER].

Aparece la siguiente pantalla.

SAVE USER2

6. Pulse [MENU] para volver a la pantalla original.

Guardar las condiciones de corte más frecuen-
tes
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Aunque no se muestra en la pantalla, también se guardan la UPSPEED (la velocidad a la que se mueve la cuchi-
lla cuando no se corta) y la calidad de corte.

NOTA

Guardar las condiciones de corte más frecuentes
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Carga de condiciones de corte

Seleccione una memoria guardada y aplíquela al panel de operaciones.

Puede seleccionar una memoria de USER 1 a USER 8. Tenga en cuenta que al cargar las condiciones de cor-
te desde la memoria se borran las condiciones de corte que no se hayan guardado.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

MEMORY
<USER1>

3. Pulse [▶] dos veces.

LOAD *USER1
50-20-0.250

4. Pulse [▲][▼] para seleccionar el número de memoria que desea cargar.

5. Para ejecutar la operación pulse [ENTER].

6. Pulse [MENU] para volver a la pantalla original.

Guardar las condiciones de corte más frecuentes
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El corte perforado puede utilizarse para cortar material sin papel de soporte o para hacer pliegues en los
datos cortados.

La zona de corte se separa tras el corte para evitar que el material se atasque.

 ENLACES RELACIONADOS 

・  P. 27 Preparación del material

・  P. 41 Preparativos para la salida de corte

・  P. 57 Ajuste de las condiciones de corte

・  P. 67 Ajuste las condiciones de impresión

Creación de datos de corte perforados con CutStudio

1. Crear datos de corte perforados

Cargue previamente el material en la máquina y termine de preparar la salida de corte.
P. 27Preparación del material
P. 41Preparativos para la salida de corte

Procedimiento

1. Inicia CutStudio.

• Windows 11

a. Haga clic en [Start].

b. Haga clic en [Todas las aplicaciones]>[Roland CutStudio]>[CutStudio].

• Windows 10

En el menú [Start], haga clic en [ Roland CutStudio]>[CutStudio].

• Windows 8.1

En la parte inferior izquierda de la pantalla [Start], haga clic en  para mostrar la pantalla
de [Aplicaciones]. Haga clic en .

Se inicia CutStudio.

2. Crear una forma.

Separar la zona de corte posteriormente
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En este ejemplo, creará el diseño que se muestra en la siguiente figura.

3. Haga clic en .

El corte perforado se establece, y el objeto se muestra en rojo.

Haga clic en [File]>[Preference] para mostrar la ventana [Preference]. Permite establecer el color y la visua-
lización de las líneas perforadas.

NOTA

Para cancelar la configuración de la línea perforada, utilice  para seleccionar la forma para la que desea

cancelar el corte perforado y luego haga clic en . Una vez cancelado el ajuste de la línea perforada, el
color de la línea de corte vuelve a ser negro.

NOTA

Separar la zona de corte posteriormente

Optimización de la eficiencia en el trabajo 237



2. Ajuste las condiciones de corte perforado

Procedimiento

1. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

2. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

3. Haga clic en [Change] bajo [Media Size].

Separar la zona de corte posteriormente
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4. Haga clic en [Get from Machine].

Adquirir el área de corte de la máquina conectada, y actualizar [Width] y [Length] en [Cutting
Area].

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

5. Haga clic en [OK].

Separar la zona de corte posteriormente
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La configuración se guarda y aparece la ventana [Cutting Setup].

6. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

7. Desmarque la casilla [Use perforated cutting conditions of machine].

Esto permite introducir valores a [Perforated Cutting].

Separar la zona de corte posteriormente
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8. Ajuste [Perforation length], [Perforation Force], [Half-cut length] y [Half-cut Force] en [Perforated Cut-
ting].

• : Longitud perforación

Longitud de la pieza cortada del material

• : Longitud de semicorte

Longitud de la pieza no cortada del material con la fuerza de la cuchilla suprimida

Ajuste la fuerza de perforación o la fuerza de medio corte según el tipo de material.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longitud perforación: 20 mm Longitud perforación: 20 mm Longitud perforación: 1 mm

Longitud de semicorte: 1 mm Longitud de semicorte: 20 mm Longitud de semicorte: 20 mm

9. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

・  P. 204 Ajuste la fuerza de la cuchilla

Separar la zona de corte posteriormente
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・  P. 262 Ajuste de las condiciones de corte perforado en la máquina

Separar la zona de corte posteriormente
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3. Líneas perforadas cortadas

Procedimiento

1. Compruebe que el material se ha cargado.

2. Haga clic en .

Aparece la ventana de [Cut].

3. Seleccione el tipo de líneas de corte que desea imprimir.

[All] Salidas de líneas de corte y líneas de corte perforadas

[Solo líneas de corte] Solo salidas de líneas de corte

[Perforated Cut Lines only] Solo emite líneas de corte perforadas

4. Haga clic en [OK].

Comienza el corte.

5. Compruebe el resultado del corte.

Ajuste las condiciones de corte según sea necesario.

 ENLACES RELACIONADOS 

・  P. 238 Ajuste las condiciones de corte perforado

・  P. 202 Ajuste de la configuración de corte

Separar la zona de corte posteriormente
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Creación de datos de corte perforados con Adobe Illustrator

1. Crear datos de corte perforados

Cargue previamente el material en la máquina y termine de preparar la salida de corte.
P. 27Preparación del material
P. 41Preparativos para la salida de corte

Esta sección muestra un ejemplo de creación de datos de corte perforados con Adobe Illustrator 2020. El
procedimiento de operación es el mismo para otras versiones.

Procedimiento

1. Cree un nuevo documento y dibuje una nueva forma o abra un archivo existente.

En este ejemplo, creará el diseño que se muestra en la siguiente figura.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

Separar la zona de corte posteriormente
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3. Seleccione un objeto al que desee aplicar el corte perforado.

4. Haga clic en .

Separar la zona de corte posteriormente
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5. Seleccione [Output Perforated Cut Lines Only].

6. En la paleta, haga clic en [Update].

Compruebe que la línea de corte que desea imprimir se muestra en la pantalla de vista previa.

7. Haga clic en .

Se inicia CutStudio y los datos de corte se envían a CutStudio. Los datos de corte de salida siempre
se alinean en el origen de CutStudio independientemente de la posición en Adobe Illustrator (ex-
cepto los datos de las marcas de corte).

Separar la zona de corte posteriormente
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2. Ajuste las condiciones de corte perforado

Procedimiento

1. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

2. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

3. Haga clic en [Change] bajo [Media Size].

Separar la zona de corte posteriormente
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4. Haga clic en [Get from Machine].

Adquirir el área de corte de la máquina conectada, y actualizar [Width] y [Length] en [Cutting
Area].

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

5. Haga clic en [OK].

Separar la zona de corte posteriormente
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La configuración se guarda y aparece la ventana [Cutting Setup].

6. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

7. Desmarque la casilla [Use perforated cutting conditions of machine].

Esto permite introducir valores a [Perforated Cutting].

Separar la zona de corte posteriormente
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8. Ajuste [Perforation length], [Perforation Force], [Half-cut length] y [Half-cut Force] en [Perforated Cut-
ting].

• : Longitud perforación

Longitud de la pieza cortada del material

• : Longitud de semicorte

Longitud de la pieza no cortada del material con la fuerza de la cuchilla suprimida

Ajuste la fuerza de perforación o la fuerza de medio corte según el tipo de material.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longitud perforación: 20 mm Longitud perforación: 20 mm Longitud perforación: 1 mm

Longitud de semicorte: 1 mm Longitud de semicorte: 20 mm Longitud de semicorte: 20 mm

9. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

・  P. 204 Ajuste la fuerza de la cuchilla

Separar la zona de corte posteriormente
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・  P. 262 Ajuste de las condiciones de corte perforado en la máquina

Separar la zona de corte posteriormente
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3. Líneas perforadas cortadas

Procedimiento

1. Compruebe que el material se ha cargado.

2. Haga clic en .

Aparece la ventana de [Cut].

3. Seleccione el tipo de líneas de corte que desea imprimir.

[All] Salidas de líneas de corte y líneas de corte perforadas

[Solo líneas de corte] Solo salidas de líneas de corte

[Perforated Cut Lines only] Solo emite líneas de corte perforadas

4. Haga clic en [OK].

Comienza el corte.

5. Compruebe el resultado del corte.

Ajuste las condiciones de corte según sea necesario.

 ENLACES RELACIONADOS 

・  P. 238 Ajuste las condiciones de corte perforado

・  P. 202 Ajuste de la configuración de corte

Separar la zona de corte posteriormente
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Creación de datos de corte perforados con CorelDRAW

1. Crear datos de corte perforados

Cargue previamente el material en la máquina y termine de preparar la salida de corte.
P. 27Preparación del material
P. 41Preparativos para la salida de corte

Esta sección explica cómo crear datos de corte para corte perforado utilizando CorelDRAW 2020. El proce-
dimiento de operación es el mismo para otras versiones.

Procedimiento

1. Cree un nuevo documento y dibuje una nueva forma o abra un archivo existente.

En este ejemplo, creará el diseño que se muestra en la siguiente figura.

2. En la barra de herramientas, haga clic en .

Aparece la paleta [Roland CutStudio].

Separar la zona de corte posteriormente
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3. Seleccione un objeto al que desee aplicar el corte perforado.

4. Haga clic en .

5. Seleccione [Output Perforated Cut Lines Only].

6. Haga clic en [Update].

Compruebe que la línea de corte que desea imprimir se muestra en la pantalla de vista previa.

7. Haga clic en .

Separar la zona de corte posteriormente
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Se inicia CutStudio y los datos de corte se envían a CutStudio. Los datos de corte de salida siempre
se alinean en el origen de CutStudio independientemente de la posición en CorelDRAW (excepto los
datos de las marcas de corte).

Separar la zona de corte posteriormente
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2. Ajuste las condiciones de corte perforado

Procedimiento

1. Haga clic en [File]>[Cutting Setup].

Aparece la ventana [Cutting Setup].

2. En [Name], en[Printer], seleccione [Roland DG GS2-24].

Se establece el nombre del modelo.

3. Haga clic en [Change] bajo [Media Size].

Separar la zona de corte posteriormente

256  Optimización de la eficiencia en el trabajo



4. Haga clic en [Get from Machine].

Adquirir el área de corte de la máquina conectada, y actualizar [Width] y [Length] en [Cutting
Area].

Si aparece [The machine is not responding.], compruebe la configuración de esta máquina y del ordenador.

P. 303La máquina no funciona

NOTA

5. Haga clic en [OK].

Separar la zona de corte posteriormente
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La configuración se guarda y aparece la ventana [Cutting Setup].

6. Ajustar las condiciones de corte.

Normalmente, la casilla [Use cutting conditions of machine] está seleccionada.

Para cambiar la condición de corte, desmarque la casilla [Use cutting conditions of machine] e
introduzca los valores.

7. Desmarque la casilla [Use perforated cutting conditions of machine].

Esto permite introducir valores a [Perforated Cutting].

Separar la zona de corte posteriormente
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8. Ajuste [Perforation length], [Perforation Force], [Half-cut length] y [Half-cut Force] en [Perforated Cut-
ting].

• : Longitud perforación

Longitud de la pieza cortada del material

• : Longitud de semicorte

Longitud de la pieza no cortada del material con la fuerza de la cuchilla suprimida

Ajuste la fuerza de perforación o la fuerza de medio corte según el tipo de material.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longitud perforación: 20 mm Longitud perforación: 20 mm Longitud perforación: 1 mm

Longitud de semicorte: 1 mm Longitud de semicorte: 20 mm Longitud de semicorte: 20 mm

9. Haga clic en [OK].

Se guardan el rango y las condiciones de corte.

El área mostrada en blanco en CutStudio es el rango de corte. Los caracteres y las formas fuera de esta área
no se cortarán.

NOTA

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

・  P. 204 Ajuste la fuerza de la cuchilla

Separar la zona de corte posteriormente
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・  P. 262 Ajuste de las condiciones de corte perforado en la máquina

Separar la zona de corte posteriormente
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3. Líneas perforadas cortadas

Procedimiento

1. Compruebe que el material se ha cargado.

2. Haga clic en .

Aparece la ventana de [Cut].

3. Seleccione el tipo de líneas de corte que desea imprimir.

[All] Salidas de líneas de corte y líneas de corte perforadas

[Solo líneas de corte] Solo salidas de líneas de corte

[Perforated Cut Lines only] Solo emite líneas de corte perforadas

4. Haga clic en [OK].

Comienza el corte.

5. Compruebe el resultado del corte.

Ajuste las condiciones de corte según sea necesario.

 ENLACES RELACIONADOS 

・  P. 238 Ajuste las condiciones de corte perforado

・  P. 202 Ajuste de la configuración de corte

Separar la zona de corte posteriormente
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Ajuste de las condiciones de corte perforado en la máquina

Configure las condiciones de corte perforado en el panel de operaciones de la máquina. En este ejemplo,
se establecerán "LONGITUD MEDIA", "MEDIA FUERZA" y"LONGITUD CORTE".

• : "LONGITUD CORTE"

Longitud de la pieza cortada del material

• : "LONGITUD MEDIA"

Longitud de la pieza no cortada del material con la fuerza de la cuchilla suprimida

Ajuste "MEDIA FUERZA" según el tipo de material.

"LONGITUD CORTE" ＞ "LONGITUD MEDIA" "LONGITUD CORTE" ＝ "LONGITUD MEDIA" "LONGITUD CORTE" ＜ "LONGITUD MEDIA"

Longitud de corte: 20 mm Longitud de corte: 20 mm Longitud de corte: 1 mm

Longitud de semicorte: 1 mm Longitud de semicorte: 20 mm Longitud de semicorte: 20 mm

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

Separar la zona de corte posteriormente
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4. Pulse [▲][▼] para que aparezca la siguiente pantalla.

PERFORATE OFF

5. Pulse [▶].

6. Pulse [▲] o [▼] para seleccionar "ON".

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [▶] dos veces para visualizar la pantalla que se muestra a continuación.

Ajuste la longitud del medio corte.

HALF LEN.  0.5

(1) Pulse [▶].

(2) Pulse [▲] o [▼] para seleccionar un valor.

HALF LEN.  0.5
* 0.5mm

(3) Pulse [ENTER] para seleccionar el ajuste.

9. Pulse [▼] para que aparezca la siguiente pantalla.

Ajuste la fuerza de medio corte.

HALF FORCE  5

(1) Pulse [▶].

(2) Pulse [▲] o [▼] para seleccionar un valor.

HALF FORCE  5
* 5gf

(3) Pulse [ENTER] para seleccionar el ajuste.

10. Pulse [▼] para que aparezca la siguiente pantalla.

Ajuste la longitud de corte.

CUT LEN. 15.5

(1) Pulse [▶].

(2) Pulse [▲] o [▼] para seleccionar un valor.

CUT LEN. 15.5
  15.5mm

(3) Pulse [ENTER] para seleccionar el ajuste.

11. Pulse [MENU] para volver a la pantalla original.

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

Separar la zona de corte posteriormente
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Visión general de la salida en mosaico

Cuando los datos son más grandes que el rango de corte, los datos se dividen en múltiples trozos de mate-
rial para su salida.

La salida en mosaico no está disponible para los datos de Imprimir y Cortar.

IMPORTANTE

Función de margen interior

Para evitar huecos al conectar diferentes piezas de material, el borde de cada pieza de salida en mosaico
puede tener un área de corte adicional. La parte extra que se corta se llama margen interno ( ). Puede
ajustar el margen interior según sus necesidades.

• Sin margen interior: Espacio entre los bordes cuando las piezas están conectadas

• Con margen interior: No hay espacio entre los bordes cuando las piezas están conectadas

Dividir los datos de corte y emitirlos en varias
piezas de material

264  Optimización de la eficiencia en el trabajo



Paso 1: Decida en cuántas piezas se va a dividir (panel)

Cuando se imprimen datos de corte divididos (panelado), es útil imaginar de antemano el tamaño final.

Esta sección explica el caso de corte de datos de gran tamaño, como se muestra a continuación.

550 mm

1.000 mm

1.000 mm

Procedimiento

1. Determina el tamaño de salida de los datos.

1.000 mm

1.000 mm

2. Compruebe el tamaño del material y decida cuántas piezas va a utilizar.

En este ejemplo, la salida de datos se realiza dividiendo los datos en 2 (vertical) x 2 (horizontal).
Asegúrese de que el tamaño del material combinado es mayor que el tamaño de los datos de sali-
da.

550 mm

Dividir los datos de corte y emitirlos en varias piezas de material
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550 mm

Dividir los datos de corte y emitirlos en varias piezas de material
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Paso 2: Ajuste las condiciones de salida de los mosaicos

Activar o desactivar la salida en mosaico y los márgenes interiores.

Cargue previamente el material en la máquina y termine de preparar la salida de corte.
P. 27Preparación del material
P. 41Preparativos para la salida de corte

Procedimiento

1. Inicia CutStudio.

2. Haga clic en [File]>[Tiling].

Aparece la ventana [Tiling].

3. Haga clic en [Change Size].

Dividir los datos de corte y emitirlos en varias piezas de material
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4. Haga clic en [Get from Machine].

El rango de corte se adquiere de la máquina conectada, y los valores se introducen automática-
mente.

5. Una vez introducidos los valores automáticamente, haga clic en [OK].

Se actualiza el tamaño del segmento.

Dividir los datos de corte y emitirlos en varias piezas de material
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6. Seleccione la casilla de verificación [Tiled Output] y, a continuación, introduzca el número de mosaicos.

7. Ajuste los márgenes interiores.

Si se introduce [Inner Margin], se actualiza automáticamente [Overall Size]. Asegúrese de que
[Overall Size] es mayor que el tamaño de impresión.

8. Haga clic en [OK].

Dividir los datos de corte y emitirlos en varias piezas de material
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Aparece el documento. Los bordes de los segmentos se muestran incluso si no se ha establecido un
margen interior.

 ENLACES RELACIONADOS 

・  P. 264 Visión general de la salida en mosaico

・  P. 265 Decida en cuántas piezas se va a dividir (panel)

Dividir los datos de corte y emitirlos en varias piezas de material
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Paso 3: Crear datos de corte

Cree los datos de corte y compruebe el orden de salida y las condiciones de corte en la vista previa.

Procedimiento

1. Introduzca el texto y/o las formas que desee.

En este ejemplo, introducirá los datos que se muestran en la siguiente figura.

2. Haga clic en [File]>[Cutting Preview].

Dividir los datos de corte y emitirlos en varias piezas de material
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Al hacer clic en [Next Page], se muestran las vistas previas en el orden de corte.

Dividir los datos de corte y emitirlos en varias piezas de material
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Orden de corte

3. Compruebe los datos de corte y cierre la vista previa.

Dividir los datos de corte y emitirlos en varias piezas de material
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Paso 4: Cortando

Comienza el corte de mosaico.

Procedimiento

1. Compruebe que el material se ha cargado.

2. Haga clic en .

Aparece la ventana [DivCut Page].

3. Haga clic en [OK].

Aparece la ventana [Cut].

4. Haga clic en [OK].

Dividir los datos de corte y emitirlos en varias piezas de material

274  Optimización de la eficiencia en el trabajo



Comienza el corte.

Una vez finalizado el corte, se muestra una pantalla de mensajes.

Cuando utilice material plano, cargue un nuevo material plano.

NOTA

5. Haga clic en [OK].

Dividir los datos de corte y emitirlos en varias piezas de material

Optimización de la eficiencia en el trabajo 275



6. Repita los pasos 4 y 5.

Imprime el número de mosaicos establecido.

7. Combine el material de salida.

Alinee los márgenes para completar el procedimiento.

Dividir los datos de corte y emitirlos en varias piezas de material
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Optimización de la gestión
de operaciones

Gestión de los ajustes básicos de la máquina.................................................... 278
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Modificación de la unidad de longitud a mostrar ......................................... 278
Ajuste del brillo de la pantalla............................................................... 280
Restaurar la configuración predeterminada ............................................... 281
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Cambiar el idioma de la pantalla

Procedimiento

1. Cuando la máquina esté encendida, pulse el botón de encendido durante 1 segundo o más para desconec-
tar la alimentación.

2. Mantenga pulsado [MENU] y pulse el botón de encendido.

Aparece la siguiente pantalla.

LANG. ENGLISH
*ENGLISH

3. Pulse [▼] para seleccionar el idioma que se mostrará en la pantalla.

LANG  ENGLISH
にほんこﾞ

4. Pulse [ENTER] para seleccionar el ajuste.

Modificación de la unidad de longitud a mostrar

Cambia la unidad que se utiliza para la visualización.

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶], [▼] y luego [▶].

Gestión de los ajustes básicos de la máquina
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UNIT mm
*mm

4. Seleccione la unidad con [▲][▼].

Es posible seleccionar milímetros o pulgadas.

5. Pulse [ENTER] para seleccionar el ajuste.

6. Pulse [MENU] para volver a la pantalla original.

Gestión de los ajustes básicos de la máquina
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Ajuste del brillo de la pantalla

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

CONTRAST 5

5. Pulse [▶].

6. Pulse [▲][▼] para seleccionar el brillo de la pantalla.

CONTRAST 5
*5

• Rango de ajuste: 1 a 5

7. Pulse [ENTER] para seleccionar el ajuste.

8. Pulse [MENU] para volver a la pantalla original.

Gestión de los ajustes básicos de la máquina
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Restaurar la configuración predeterminada

Este procedimiento devuelve todos los ajustes a sus valores predeterminados de fábrica.

Esta operación restablece todos los ajustes a su configuración predeterminada, borrando todos los cambios realizados
hasta ese momento. Mantenga un registro de toda la información necesaria, como las condiciones de corte.
Sin embargo, la configuración del idioma no cambia.

NOTA

Procedimiento

1. Pulse [MENU] varias veces para que aparezca la siguiente pantalla.

CONDITION

Cuando el material esté cargado, pulse varias veces [MENU] para que aparezca la siguiente pantalla.

UNSETUP

NOTA

2. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

OTHERS

3. Pulse [▶].

4. Pulse [▼] varias veces para que aparezca la siguiente pantalla.

FACTORYDEFAULT
*PRESET

5. Pulse [▶] para que aparezca la siguiente pantalla.

FACTORYDEFAULT
*PRESET

6. Para ejecutar la operación pulse [ENTER].

Aparece de nuevo la pantalla que se muestra a continuación.

SELECT SHEET
ROLL

Gestión de los ajustes básicos de la máquina

Optimización de la gestión de operaciones 281



Mantenimiento

282



Limpieza y piezas consumi-
bles

Limpiando.............................................................................................. 284
Limpieza de la máquina....................................................................... 284
Limpieza de la tapa del soporte de la cuchilla ............................................ 286

Piezas consumibles ................................................................................... 288
Cuchilla .......................................................................................... 288
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Protector de la cuchilla ....................................................................... 290
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La limpieza es importante para garantizar un corte limpio. Limpie la máquina periódicamente.

Asegúrese de realizar las operaciones indicadas en las instrucciones y no toque ninguna zona que
no se especifique en las instrucciones.
Los movimientos repentinos del equipo podrían provocar lesiones o quemaduras.

ADVERTENCIA

Nunca utilice un solvente como gasolina, alcohol o diluyente para realizar la limpieza.
Si lo hiciera, podría provocar un incendio.

ADVERTENCIA

Limpieza de la máquina

Limpie la suciedad y la mugre con un paño humedecido con agua y luego escurrido con firmeza.

Desconecte la alimentación antes de limpiar.

IMPORTANTE

Baje la palanca de carga antes de limpiar.

IMPORTANTE

Limpiando
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Rodillo de arrastre Sujete el rodillo con la mano para que no gire y limpie la suciedad y los restos de
material de la parte de goma del rodillo de arrastre. A continuación, limpie con un
paño seco.

Mostrar Límpielo con un paño seco.

Rodillo de presión Después de levantar todos los rodillos de arrastre, gire el rodillo de presión mien-
tras utiliza un cepillo. Utilice *1 para eliminar el polvo de la superficie.

 

*1 No utilice un cepillo metálico.
 

Limpiando
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Limpieza de la tapa del soporte de la cuchilla

Cuando un soporte de la cuchilla se ha utilizado durante mucho tiempo, el cojinete que soporta la cuchilla
se deteriora, dificultando el giro de la misma. Si sigue utilizando el soporte de la cuchilla de esta manera,
la máquina no cortará limpiamente porque la punta de la cuchilla no girará suavemente.

Si aparece alguna de las siguientes condiciones, limpie la tapa del soporte de la cuchilla.

• Las esquinas y las curvas no son limpias

• Las líneas de corte están perforadas

No toque jamás la punta de la cuchilla.
Si lo hiciera, podría lesionarse. El rendimiento de corte de la cuchilla también podría verse alterado.

PRECAUCIÓN

Afloje la tapa para extraerla y elimine cualquier acumulación de material o polvo dentro de la tapa.

Si la limpieza no mejora las condiciones, sustituya el soporte de la cuchilla por uno nuevo.

NOTA

 ENLACES RELACIONADOS 

Limpiando
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・  P. 288 Sustituir la cuchilla

Limpiando
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Para comprar artículos consumibles, visite el sitio web de DGSHAPE Corporation o póngase en contacto con
su distribuidor autorizado de DGSHAPE Corporation.

 ENLACES RELACIONADOS 

・ https://www.rolanddg.co.jp/

Cuchilla

Cuchilla

En los casos siguientes, la cuchilla ha llegado al final de su vida útil. Cámbielo por uno nuevo.

• La punta de la cuchilla está rota.

• Las zonas sin cortar permanecen aunque la fuerza de la cuchilla se haya incrementado a 50 o 60 gf.

• Los cortes no son tan limpios como antes

• El material comienza a enroscarse desde el papel de soporte cuando se cortan áreas detalladas o es-
quinas

La punta de una cuchilla que se ha utilizado durante mucho tiempo o que se ha utilizado para cortar mate-
rial duro puede desgastarse. Una cuchilla que se haya desgastado de esta manera ya no cortará limpiamen-
te, así que sustitúyala por una nueva.

 ENLACES RELACIONADOS 

・  P. 288 Sustituir la cuchilla

Sustituir la cuchilla

Si la cuchilla se desafila, sustitúyala por la cuchilla de repuesto incluida.

Asegúrese de realizar las operaciones indicadas en las instrucciones y no toque ninguna zona que
no se especifique en las instrucciones.
Los movimientos repentinos del equipo podrían provocar lesiones o quemaduras.

ADVERTENCIA

No toque jamás la punta de la cuchilla.
Si lo hiciera, podría lesionarse. El rendimiento de corte de la cuchilla también podría verse alterado.

PRECAUCIÓN

Procedimiento

Piezas consumibles
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1. Retire el material cargado en la máquina.

2. Desmonte el soporte de la cuchilla.

3. Sustituir la cuchilla.

(1) Pulse el pasador para sacar la cuchilla vieja.

(2) Inserte una nueva cuchilla.

4. Instale el soporte de la cuchilla en el carro de corte.

5. Asegúrese de que el tornillo esté apretado.

 ENLACES RELACIONADOS 

・  P. 174 Retirada del material

・  P. 202 Ajustar la profundidad de corte

Piezas consumibles
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Soporte de la cuchilla

Soporte de la cuchilla

Si el corte se realiza con la punta de la cuchilla ajustada, la tapa del soporte de la cuchilla y el material se
rozan, desgastando gradualmente la punta de la tapa. Un desgaste importante impide el ajuste correcto
de la punta de la cuchilla, impidiendo un corte limpio. Cuando esto ocurra, sustituya el soporte de la cu-
chilla por uno nuevo.

 ENLACES RELACIONADOS 

・  P. 286 Limpieza de la tapa del soporte de la cuchilla

Protector de la cuchilla

Protector de la cuchilla

Si se realiza el corte cuando la extensión de la cuchilla o la fuerza de la cuchilla no están ajustadas ade-
cuadamente, la punta de la cuchilla puede perforar el papel de soporte del material y rayar el protector
de la cuchilla. Si se realiza el corte cuando el protector de la cuchilla está rayado, es posible que los cor-
tes realizados no sean limpios.

En los casos siguientes, sustituya el protector de la cuchilla.

• La superficie del protector de la cuchilla está deformada debido a arañazos o daños similares.

• Se ha deteriorado hasta el punto de que se está cayendo a pedazos

 ENLACES RELACIONADOS 

・ https://www.rolanddg.co.jp/

Piezas consumibles
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Métodos de resolución de
problemas

291



Problemas de corte
La impresión y el corte están desalineados ...................................................... 293

¿Se utiliza un material grueso? ............................................................... 293
¿Está la máquina configurada para avanzar cierta cantidad de material antes

de cortar? ................................................................................. 293

Quedan zonas sin cortar o los bordes cortados no están limpios ............................. 294
¿Están la cuchilla y el soporte de la cuchilla correctamente instalados?.............. 294
¿Está rota la punta de la hoja? ............................................................... 294
¿Hay alguna acumulación de polvo o material adhesivo en la punta de la cu-

chilla? ...................................................................................... 294
¿Hay alguna acumulación de trozos de material o polvo en el interior del so-

porte de la cuchilla?..................................................................... 294
¿Se utiliza un material grueso? ............................................................... 294
¿Son adecuadas la fuerza de la cuchilla y la velocidad de corte? ...................... 294
¿Es adecuado el desplazamiento de la punta de la cuchilla? ............................ 295
¿Está la máquina configurada para avanzar cierta cantidad de material antes

de cortar? ................................................................................. 295
¿Se ha "SUAVIZADO" ajustado en "OFF"? ..................................................... 295
¿El protector de la cuchilla está dañado o deformado? .................................. 295

el equipo corta el papel portador.................................................................. 296
¿Son el ajuste de la punta de la cuchilla y la fuerza de la cuchilla adecuados

para el material que se está cortando? .............................................. 296

el equipo corta el mismo área dos veces ......................................................... 297
¿Está el [Overlap Cutting] ajustado a [0] en CutStudio? ................................ 297
¿El ajuste [OVERLAP] de la máquina es un número del 1 al 10? ........................ 297
¿Hay líneas superpuestas?..................................................................... 297

No se detectan las marcas de corte ............................................................... 298
¿Está el material cargado correctamente? ................................................. 298
¿Está utilizando material que no sea blanco o que sea brillante? ...................... 298
¿Utiliza materiales transparentes?........................................................... 298
¿El material tiene pliegues o arrugas? ...................................................... 298
¿Las marcas de corte están borrosas o son de un color distinto al negro? ............ 298
¿Son correctos el tamaño y la forma de las marcas de corte? .......................... 299
¿Están las marcas de corte en las posiciones correctas? ................................. 299
¿Está el menú "ROTAR" ajustado a "90deg"? ................................................ 299
¿La máquina está expuesta a la luz solar directa o a una iluminación interior

intensa?.................................................................................... 299
¿Está el material cargado y colocado de forma recta y segura? ¿Están los re-

sultados de impresión torcidos? ....................................................... 299
¿Coinciden las distancias entre las marcas de corte especificadas por el soft-

ware con las especificadas en la máquina? (Modo manual) ....................... 300
¿Se ha ampliado o reducido la impresión?.................................................. 300

El material se aleja de los rodillos de arrastre durante el corte ............................. 301
¿Está bajada la palanca de carga? ........................................................... 301
¿Está el material cargado en paralelo a las líneas guía? ................................. 301
¿El material entra en contacto con algún obstáculo durante el corte? ................ 301
¿Se ha realizado el corte sin comprobar el avance del material? (material en

rollo) ....................................................................................... 301
¿Se utilizan los rodillos de arrastre para asegurar ambos bordes del material? ...... 301
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 ENLACES RELACIONADOS 

・  P. 223 Ajustar la posición de corte

・  P. 225 Ajustar la posición de impresión

¿Se utiliza un material grueso?

Si se utiliza material grueso, ajuste "CALIDAD" a "PESADO".

 ENLACES RELACIONADOS 

・  P. 206 Ajuste de la velocidad de corte

¿Está la máquina configurada para avanzar cierta cantidad de material antes
de cortar?

Cuando utilice material en rollo o material plano de más de 1,6 m, si el corte se realiza sin que la longitud
de material requerida para los datos de corte sea alimentada hacia adelante, el material puede resbalar o
la operación puede detenerse debido a un error del motor.

Ajuste la máquina para que la cantidad necesaria de material avance antes de cortar.

 ENLACES RELACIONADOS 

・  P. 40 Comprobar la alimentación de material

La impresión y el corte están desalineados
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¿Están la cuchilla y el soporte de la cuchilla correctamente instalados?

Asegúrese de que los tornillos estén bien apretados para que no se suelten durante el corte.

 ENLACES RELACIONADOS 

・  P. 288 Sustituir la cuchilla

¿Está rota la punta de la hoja?

Si es así, sustituya la cuchilla por una nueva.

 ENLACES RELACIONADOS 

・  P. 288 Sustituir la cuchilla

¿Hay alguna acumulación de polvo o material adhesivo en la punta de la cuchi-
lla?

Retire y limpie la cuchilla.

 ENLACES RELACIONADOS 

・  P. 288 Sustituir la cuchilla

¿Hay alguna acumulación de trozos de material o polvo en el interior del so-
porte de la cuchilla?

Saque la punta del soporte de la cuchilla y retire los trozos de material o el polvo que haya en su interior.

 ENLACES RELACIONADOS 

・  P. 286 Limpieza de la tapa del soporte de la cuchilla

¿Se utiliza un material grueso?

Si se utiliza material grueso, ajuste "CALIDAD" a "PESADO".

 ENLACES RELACIONADOS 

・  P. 206 Ajuste de la velocidad de corte

¿Son adecuadas la fuerza de la cuchilla y la velocidad de corte?

Realice pruebas de corte y ajuste la configuración hasta que el corte pueda realizarse adecuadamente.

 ENLACES RELACIONADOS 

Quedan zonas sin cortar o los bordes cortados
no están limpios
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・  P. 204 Ajuste la fuerza de la cuchilla

・  P. 213 Ajuste de la velocidad de la cuchilla durante el corte

・  P. 45 Realizar corte de prueba

¿Es adecuado el desplazamiento de la punta de la cuchilla?

Si el ajuste de desplazamiento no es correcto para la punta de la cuchilla, las esquinas pueden ser redon-
deadas o tener cuernos.

Ajuste un valor adecuado para el desplazamiento de la punta de la cuchilla.

 ENLACES RELACIONADOS 

・  P. 207 Ajuste del desplazamiento de la punta de la cuchilla

¿Está la máquina configurada para avanzar cierta cantidad de material antes
de cortar?

Cuando utilice material en rollo o material plano de más de 1,6 m, si el corte se realiza sin que la longitud
de material requerida para los datos de corte sea alimentada hacia adelante, el material puede resbalar o
la operación puede detenerse debido a un error del motor.

Ajuste la máquina para que la cantidad necesaria de material avance antes de cortar.

 ENLACES RELACIONADOS 

・  P. 40 Comprobar la alimentación de material

¿Se ha "SUAVIZADO" ajustado en "OFF"?

Para cortar las curvas limpiamente, ajuste "SUAVIZADO" a"ON".

 ENLACES RELACIONADOS 

・  P. 214 Suavizar los arcos de corte y otras curvas (suavizar)

¿El protector de la cuchilla está dañado o deformado?

Si el protector de la cuchilla está dañado, es posible que el material no se corte correctamente aunque los
ajustes de la máquina y la instalación de la cuchilla y el soporte de la cuchilla sean correctos. Si esto ocu-
rre, póngase en contacto con su distribuidor autorizado de Roland DG Corporation.

 ENLACES RELACIONADOS 

・  P. 290 Protector de la cuchilla

Quedan zonas sin cortar o los bordes cortados no están limpios
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¿Son el ajuste de la punta de la cuchilla y la fuerza de la cuchilla adecuados
para el material que se está cortando?

Realice una prueba de corte y ajuste adecuadamente la punta y la fuerza de la cuchilla.

 ENLACES RELACIONADOS 

・  P. 201 Guía general sobre las condiciones de corte

・  P. 45 Realizar corte de prueba

・  P. 202 Ajustar la profundidad de corte

el equipo corta el papel portador
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¿Está el [Overlap Cutting] ajustado a [0] en CutStudio?

Si el [Overlap Cutting] se ajusta a cualquier número distinto de [0] en la pantalla de [Cut], el número se
añade al número de cortes. Ajuste el [Overlap Cutting] a [0] o ajuste [SOBRECORTAR] a [OFF] en la má-
quina.

 ENLACES RELACIONADOS 

・  P. 81 Cortando

¿El ajuste [OVERLAP] de la máquina es un número del 1 al 10?

Ajuste la máquina en "SOBRECORTAR" a "OFF".

 ENLACES RELACIONADOS 

・  P. 215 Cortar en la misma posición repetidamente (solapamiento)

¿Hay líneas superpuestas?

Es posible que se hayan copiado los mismos datos, lo que da lugar a líneas superpuestas. Compruebe los
datos.

el equipo corta el mismo área dos veces
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Cuando la máquina no puede leer las marcas de corte, muestra el siguiente mensaje de error y detiene el
funcionamiento.

• "AJUSTE MODO HER <MODO HERRAM>"

• "ERROR LARGO"

• "ERROR ANCHO"

• "ERROR ALINEAC."

Si esto ocurre, pulse cualquier tecla del panel de control. Retire el material, compruebe los siguientes ele-
mentos y vuelva a cargar el material.

¿Está el material cargado correctamente?

Asegúrese de que el material está cargado y configurado correctamente.

 ENLACES RELACIONADOS 

・  P. 27 Preparación del material

¿Está utilizando material que no sea blanco o que sea brillante?

Las marcas de corte no se pueden detectar si hay decoraciones o colores en el material. Las marcas de
corte tampoco pueden detectarse en el material brillante aunque sea blanco.

Prepare un material blanco y mate (mínimamente brillante) y vuelva a realizar el proceso desde la etapa
de impresión.

 ENLACES RELACIONADOS 

・  P. 15 Condiciones de los materiales utilizables

¿Utiliza materiales transparentes?

Las marcas de corte no pueden detectarse en material transparente. Cambia el material que está utilizan-
do.

 ENLACES RELACIONADOS 

・  P. 15 Condiciones de los materiales utilizables

¿El material tiene pliegues o arrugas?

Las marcas de corte pueden no leerse si el material tiene pliegues o arrugas.

Estire los pliegues o las arrugas y vuelva a cargar el material. Si las marcas de corte siguen sin leerse, pre-
pare un nuevo material sin pliegues ni arrugas y vuelva a realizar la operación desde la impresión de los
datos.

¿Las marcas de corte están borrosas o son de un color distinto al negro?

Ajuste el color de las marcas de corte a negro, especifique una densidad de impresión del 100 % en su im-
presora y vuelva a imprimir los datos.

No se detectan las marcas de corte
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 ENLACES RELACIONADOS 

・  P. 17 Marcas de corte

¿Son correctos el tamaño y la forma de las marcas de corte?

La máquina solo puede detectar las marcas de corte con la forma prescrita.

Haga las marcas de corte como círculos perfectos de 10 mm de diámetro.

 ENLACES RELACIONADOS 

・  P. 17 Marcas de corte

¿Están las marcas de corte en las posiciones correctas?

Coloque las marcas de corte en las posiciones correctas.

 ENLACES RELACIONADOS 

・  P. 344 Los márgenes y la distancia entre las marcas de corte

¿Está el menú "ROTAR" ajustado a "90deg"?

Cuando utilice las marcas de corte, asegúrese de ajustar el menú "ROTAR" a "0deg".Las marcas de corte no
se pueden leer si se ajustan a "90deg".

 ENLACES RELACIONADOS 

・  P. 209 Establecer la orientación de las coordenadas de corte

¿La máquina está expuesta a la luz solar directa o a una iluminación interior
intensa?

Si el sensor del carro de corte está expuesto a la luz solar directa o a la iluminación interior, es posible que
no se detecten las marcas de corte.

Mueva la máquina a un lugar donde no esté expuesta a la luz solar directa o a la iluminación interior.

Si el problema no se resuelve incluso después de seguir los pasos anteriores, realice la alineación con "MO-
DO HERRAMIEN".

 ENLACES RELACIONADOS 

・  P. 179 Imprimir y Cortar en Tool Mode

¿Está el material cargado y colocado de forma recta y segura? ¿Están los resul-
tados de impresión torcidos?

Las marcas de corte no se pueden detectar en los siguientes casos: Asegúrese de que el material se carga o
se imprime con marcas de corte rectas.

• Las marcas de corte izquierda y derecha están inclinadas 5 grados o más con respecto a la dirección de
desplazamiento del carro de corte.

No se detectan las marcas de corte
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• Las marcas de corte están desplazadas 20 mm en la dirección de avance del material.

 ENLACES RELACIONADOS 

・  P. 72 Cargue el material impreso

¿Coinciden las distancias entre las marcas de corte especificadas por el softwa-
re con las especificadas en la máquina? (Modo manual)

En la máquina, ajuste correctamente la distancia especificada por el software.

 ENLACES RELACIONADOS 

・  P. 191 Ajuste del método de alineación (modo manual)

¿Se ha ampliado o reducido la impresión?

Si el tamaño se amplía o reduce durante la impresión, las marcas de corte no pueden leerse durante el
corte.

Imprima los datos especificando el 100 % para la ampliación.

No se detectan las marcas de corte
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¿Está bajada la palanca de carga?

Si lo es, el material no está asegurado en su lugar. Compruebe que los rodillos de arrastre están dentro de
los bordes del material y suba la palanca de carga.

¿Está el material cargado en paralelo a las líneas guía?

Utilice material con bordes izquierdo y derecho paralelos, y alinee el borde izquierdo del material de ma-
nera que quede paralelo a las líneas guía.

 ENLACES RELACIONADOS 

・  P. 27 Posición de carga del material

¿El material entra en contacto con algún obstáculo durante el corte?

Asegúrese de que los bordes izquierdo y derecho del material no entren en contacto con las superficies
interiores de la máquina durante el corte. Este contacto no solo daña el material, sino que también difi-
culta el avance normal del material y hace que éste se salga de su posición.

¿Se ha realizado el corte sin comprobar el avance del material? (material en
rollo)

Si comienza a cortar sin comprobar el avance del material, es posible que no se obtengan resultados de
corte correctos. En el peor de los casos, puede provocar un error, un mal funcionamiento o dañar el mate-
rial.

 ENLACES RELACIONADOS 

・  P. 40 Comprobar la alimentación de material

¿Se utilizan los rodillos de arrastre para asegurar ambos bordes del material?

Si los rodillos de arrastre no se colocan dentro del rango de los rodillos de presión, el material no está
fijado, lo que impide que se avance correctamente.

Recarga el material.

 ENLACES RELACIONADOS 

・  P. 27 Posición de carga del material

El material se aleja de los rodillos de arrastre du-
rante el corte

Problemas de corte 301



Problemas con el equipo
La máquina no funciona ............................................................................. 303

¿Están los cables conectados correctamente? ............................................. 303
¿Está desconectada la alimentación?........................................................ 303
¿Se ha configurado el material? .............................................................. 303
¿Son incorrectos los ajustes de la aplicación de software? .............................. 303

No se puede desactivar la alimentación .......................................................... 304
¿Has mantenido pulsado el botón de encendido durante 1 segundo o más? .......... 304

No se puede configurar el material de corte con "PIEZA" ...................................... 305
¿El material que avanza es de 1,6 m o más? ............................................... 305

Conectar más de un equipo a un ordenador (Windows) ........................................ 306
Conexión por cable USB ....................................................................... 306
Conexión por Ethernet ........................................................................ 309

Conecte más de un equipo a un ordenador (Mac) ............................................... 312
Conexión por Ethernet (Dirección IP configurada manualmente) ..................... 312
Conexión por Ethernet (Dirección IP establecida automáticamente) .................. 317

302  Problemas con el equipo



¿Están los cables conectados correctamente?

Compruebe que el cable de alimentación, el cable USB y el cable Ethernet están conectados correctamen-
te.

Cuando un cable USB y un cable Ethernet están conectados al mismo tiempo, la máquina a veces no fun-
ciona. Conecte solo uno de estos cables.

¿Está desconectada la alimentación?

Conecte la alimentación de la máquina.

 ENLACES RELACIONADOS 

・  P. 20 Conexión de la alimentación

¿Se ha configurado el material?

Mientras aparezca la pantalla que se muestra a continuación, el corte no estará disponible aunque se en-
víen los datos.

Seleccione el material cargado y, a continuación, pulse [ENTER] para completar la configuración.

SELECT SHEET
ROLL

 ENLACES RELACIONADOS 

・  P. 27 Preparación del material

¿Son incorrectos los ajustes de la aplicación de software?

Seleccione el controlador adecuado para la máquina. Para el procedimiento de selección, consulte el ma-
nual del software de aplicación.

La máquina no funciona
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¿Has mantenido pulsado el botón de encendido durante 1 segundo o más?

Pulse el botón de encendido durante 1 segundo o más para desconectar la alimentación. Si la alimentación
sigue sin apagarse, desconecte el adaptador de CA de la máquina.

No se puede desactivar la alimentación

304  Problemas con el equipo



¿El material que avanza es de 1,6 m o más?

Si el material plano de 1,6 m o más se configura utilizando "PIEZA", la máquina lo reconoce como un rollo.

 ENLACES RELACIONADOS 

・  P. 15 Tipos de materiales

No se puede configurar el material de corte con
"PIEZA"
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Conexión por cable USB

Puede conectar hasta cinco unidades GS2-24 a un solo ordenador. Cuando se conectan varias unidades
GS2-24 a través de una conexión USB, se debe cambiar el número de USB de cada máquina para poder dis-
tinguir los destinos de salida. La configuración predeterminada de la máquina es "A". Cuando se conectan
dos o más máquinas, la segunda máquina y cada una de las máquinas posteriores deben configurarse con
una configuración distinta de "A" para que la máquina pueda distinguir el destino de salida de los datos.

Realice del procedimiento 1 al 3 para establecer una conexión. El mismo procedimiento puede utilizarse
para conectar una tercera unidad o las siguientes.

Paso 1: Cambie el número de USB de la máquina

No conecte todavía la máquina al ordenador con el cable USB. Hacerlo puede interferir con la aplicación correcta de los
ajustes.

IMPORTANTE

Procedimiento

1. Desconecte la alimentación de la máquina.

2. Pulse [TEST] y el botón de encendido al mismo tiempo.

Aparece la siguiente pantalla.

USB NUMBER [A]
*A

3. Pulse [▲] y [▼] para seleccionar un ajuste distinto de "A".

Es posible seleccionar un valor de "B" a "E". En este ejemplo, se selecciona "B".

4. Pulse [ENTER].

5. Apague la alimentación y vuelva a encenderla.

Aparece la siguiente pantalla. Compruebe que se muestra la letra que ha ajustado en el procedi-
miento 3.

Roland GS2-24
[B]  Main:V***

Conectar más de un equipo a un ordenador
(Windows)
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Paso 2: Cambie la configuración de la impresora del ordenador

Procedimiento

1. Conecte la máquina al ordenador mediante el cable USB.

El controlador está instalado.

2. Abrir [Devices And Printers].

• Windows 11

a. Haga clic en [Start]>[Todas las aplicaciones]>[Herramienta Windows].

b. Haga doble clic en [Contorol Panel].

c. Haga clic en [Dispositivos e impresoras].

• Windows 10

a. Haga clic en [Start]>[Sistema de Windows]>[Contorol Panel].

b. Haga clic en [Dispositivos e impresoras].

• Windows 8.1

a. Apunte a la esquina inferior derecha de la pantalla para mostrar los accesos y, a continua-
ción, haz clic en [Configuración].

b. Haga clic en [Contorol Panel].

c. Haga clic en [Hardware y sonido]>[Dispositivos e impresoras].

Se crea [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)]).

3. Haga clic con el botón derecho del ratón en [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)], y
seleccione[Printer Properties].

4. Cambie [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)]) por [Roland DG GS2-24 (B)].

5. Haga clic en [OK].

Conectar más de un equipo a un ordenador (Windows)
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Paso 3: Compruebe que se ha instalado el segundo GS2-24

Procedimiento

1. Inicia CutStudio.

2. Haga clic en [File]>[Cutting Setup].

3. Haga clic en el [Printer Name].

Si se indica [Roland DG GS2-24 (B)], la segunda máquina está correctamente conectada.

Conectar más de un equipo a un ordenador (Windows)
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Conexión por Ethernet

Puede conectar hasta cinco unidades GS2-24 a un solo ordenador. Al conectar varias máquinas a un ordena-
dor mediante Ethernet, instale un controlador a medida que añada cada máquina.

Realice del procedimiento 1 al 3 para establecer una conexión. El mismo procedimiento puede utilizarse
para conectar una tercera unidad o las siguientes.

Paso 1: Instalación del controlador de la máquina que se va a añadir

Procedimiento

1. Conecte la máquina a añadir a la misma LAN que el ordenador mediante un cable Ethernet.

2. Instale el controlador en el ordenador.

Consulte la sección «Instalación del software con la dirección IP configurada automáticamente» en
el manual «Instalación y configuración inicial Versión de Windows» (https://downloadcen-
ter.rolanddg.com/GS2-24), e instale el controlador en el ordenador.

Conectar más de un equipo a un ordenador (Windows)
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Paso 2: Cambie la configuración de la impresora del ordenador

Procedimiento

1. Abrir [Devices And Printers].

• Windows 11

a. Haga clic en [Start]>[Todas las aplicaciones]>[Herramienta Windows].

b. Haga doble clic en [Contorol Panel].

c. Haga clic en [Dispositivos e impresoras].

• Windows 10

a. Haga clic en [Start]>[Sistema de Windows]>[Contorol Panel].

b. Haga clic en [Dispositivos e impresoras].

• Windows 8.1

a. Apunte a la esquina inferior derecha de la pantalla para mostrar los accesos y, a continua-
ción, haz clic en [Configuración].

b. Haga clic en [Contorol Panel].

c. Haga clic en [Hardware y sonido]>[Dispositivos e impresoras].

Se crea [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)]).

2. Haga clic con el botón derecho del ratón en [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)], y
seleccione[Printer Properties].

3. Cambie [Roland DG GS2-24 (1)] (o [Roland DG GS2-24 (1 copia)]) por [Roland DG GS2-24 (B)].

4. Haga clic en [OK].

Conectar más de un equipo a un ordenador (Windows)
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Paso 3: Compruebe que se ha instalado el segundo GS2-24

Procedimiento

1. Inicia CutStudio.

2. Haga clic en [File]>[Cutting Setup].

3. Haga clic en el [Printer Name].

Si se indica [Roland DG GS2-24 (B)], la segunda máquina está correctamente conectada.

Conectar más de un equipo a un ordenador (Windows)
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No es posible conectar varias máquinas a un ordenador por USB.
Para conectar varias máquinas, cambie de USB a Ethernet para la conexión entre el ordenador y cada máquina.

NOTA

Conexión por Ethernet (Dirección IP configurada manualmente)

Con un ordenador Macintosh, utilice un complemento de Adobe Illustrator para imprimir en la máquina.
Cuando se conecten varias máquinas a un ordenador, establezca conexiones Ethernet entre el ordenador y
cada máquina.

Paso 1: Conectar los cables LAN

Procedimiento

1. Inicie el ordenador.

2. Pulse el botón de encendido para poner en marcha la máquina que se va a conectar.

3. Conecte la máquina y el ordenador con un cable LAN.

Conecte más de un equipo a un ordenador (Mac)
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Paso 2: Configuración de la dirección IP de la máquina a conectar

Procedimiento

1. Determine la dirección IP de la máquina.

Compruebe la dirección IP del ordenador para determinar la dirección IP de la máquina.

Cuando la dirección IP del ordenador es 192.168.0.xxx

• Dirección IP de la máquina: 192. 168. 0. yyy

Introduzca cualquier número del 1 al 254 para [yyy]. Asegúrese de que son diferentes de los
números de otros equipos de red.

2. Si la máquina está apagada, pulse el botón de encendido para ponerla en marcha.

3. Pulse [MENU] dos veces para visualizar la pantalla que se muestra a continuación.

CONDITION

4. Pulse [▼] una vez para mostrar la pantalla que se muestra a continuación.

SYSTEM INFO.

5. Pulse [▶] una vez para mostrar la pantalla que se muestra a continuación.

SYSTEM INFO.
MODEL

6. Pulse [▼] tres veces para visualizar la pantalla que se muestra a continuación.

SYSTEM INFO.
INTERFACE

7. Pulse [▶] dos veces para visualizar la pantalla que se muestra a continuación.

NETWORK
DHCP ON

Conecte más de un equipo a un ordenador (Mac)
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8. Pulse [▶], y luego [▼] para establecer el DHCP en OFF.

DHCP ON
 OFF

9. Pulse [ENTER].

10. Pulse [▼] una vez para mostrar la pantalla que se muestra a continuación.

NETWORK
IP ADDRESS

11. Pulse [▶] dos veces.

a. Pulse [▲] o [▼] para introducir la dirección IP de la máquina que determinó en el procedi-
miento 1.

Pulse [◀] o [▶] para mover el cursor.

b. Pulse [ENTER].

12. Pulse [MENU] para volver a la pantalla original.

13. Repita los procedimientos 1 a 12 para configurar la dirección IP de la segunda máquina.

Conecte más de un equipo a un ordenador (Mac)
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Paso 3: Configuración de los ajustes de salida del complemento de Adobe Illus-
trator

Procedimiento

1. Inicie Adobe Illustrator.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

3. Seleccione [GS2-24] en la lista [Model].

Conecte más de un equipo a un ordenador (Mac)
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4. Haga clic en  y, a continuación, seleccione [Connection].

5. Seleccione [IP] y, a continuación, introduzca la dirección IP que determinó en el procedimiento 1 de
[Paso 2: Configuración de la dirección IP de la máquina a conectar].

Ejemplo:

Si la dirección IP de la máquina es [192.168.000.061], introduzca [192.168.0.61].

6. Haga clic en [Verify].

Si la conexión con la máquina se establece con éxito, aparece [Success!].

Si aparece [Failed.], compruebe si la dirección IP se ha introducido correctamente.

7. Haga clic en [OK].

8. Repita los procedimientos 4 a 7 para establecer la conexión de la segunda máquina.

Puede cambiar la máquina que dará salida a los datos introduciendo la dirección IP de la máquina que dará
salida del complemento de Adobe Illustrator.

NOTA

Conecte más de un equipo a un ordenador (Mac)
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Conexión por Ethernet (Dirección IP establecida automáticamente)

Con un ordenador Macintosh, utilice un complemento de Adobe Illustrator para imprimir en la máquina.
Cuando se conecten varias máquinas a un ordenador, establezca conexiones Ethernet entre el ordenador y
cada máquina.

Paso 1: Conectar los cables LAN

Procedimiento

1. Inicie el ordenador.

2. Pulse el botón de encendido para poner en marcha la máquina que se va a conectar.

3. Conecte la máquina y el ordenador con un cable LAN.

Conecte más de un equipo a un ordenador (Mac)
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Paso 2: Comprobación de la configuración de la máquina a conectar

Procedimiento

1. Si la máquina está apagada, pulse el botón de encendido para ponerla en marcha.

2. Pulse [MENU] dos veces para visualizar la pantalla que se muestra a continuación.

CONDITION

3. Pulse [▼] una vez para mostrar la pantalla que se muestra a continuación.

SYSTEM INFO.

4. Pulse [▶] una vez para mostrar la pantalla que se muestra a continuación.

SYSTEM INFO.
MODEL

5. Pulse [▼] tres veces para visualizar la pantalla que se muestra a continuación.

SYSTEM INFO.
INTERFACE

6. Pulse [▶] dos veces para visualizar la pantalla que se muestra a continuación.

NETWORK
DHCP ON

Si el DHCP está establecido en OFF (desactivado), pulse [▶], luego [▼] para establecer el DHCP en
ON y, a continuación, pulse [ENTER].

7. Pulse [▼] una vez para mostrar la pantalla que se muestra a continuación.

NETWORK
IP ADDRESS

Conecte más de un equipo a un ordenador (Mac)
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8. Pulse [▶] una vez.

9. Anote la dirección IP mostrada.

10. Pulse [MENU] para volver a la pantalla original.

11. Repita los procedimientos 1 a 10 para comprobar los ajustes de la segunda máquina.

Conecte más de un equipo a un ordenador (Mac)
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Paso 3: Configuración de los ajustes de salida del complemento de Adobe Illus-
trator

Procedimiento

1. Inicie Adobe Illustrator.

2. Haga clic en [Window]>[Extensions]>[Roland CutStudio].

Aparece la paleta [Roland CutStudio].

3. Seleccione [GS2-24] en la lista [Model].

Conecte más de un equipo a un ordenador (Mac)
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4. Haga clic en  y, a continuación, seleccione [Connection].

5. Seleccione [IP] e introduzca la dirección IP que anotó en el procedimiento 9 de [Paso 2: Comprobación de
la configuración de la máquina a conectar].

Ejemplo:

Si la dirección IP de la máquina es [192.168.000.061], introduzca [192.168.0.61].

6. Haga clic en [Verify].

Si la conexión con la máquina se establece con éxito, aparece [Success!].

Si aparece [Failed.], compruebe si la dirección IP se ha introducido correctamente.

7. Haga clic en [OK].

8. Repita los procedimientos 4 a 7 para establecer la conexión de la segunda máquina.

Puede cambiar el destino de la salida seleccionando la dirección IP de la máquina a la que se va a dar salida
con la opción de [Connection] en el complemento de Adobe Illustrator.

NOTA

Conecte más de un equipo a un ordenador (Mac)
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Si ha cancelado la instalación o si al conectar el cable USB no se inicia el asistente, siga el procedimiento
indicado a continuación para instalar el controlador.

Reinstalar el controlador (Windows 8.1)

Procedimiento

1. Conecte la máquina al ordenador con el cable USB y encienda la máquina.

2. Si aparece el mensaje de [Nuevo hardware encontrado], haga clic en [Cerrar] para cerrarlo.

Desconecte el cable USB de todas las impresoras excepto de la máquina.

3. Apunte a la esquina inferior derecha de la pantalla para mostrar los accesos y luego haga clic en [Panel de
control]>[Hardware y sonido].

4. Haga clic en [Panel de control] y, a continuación, en [Impresoras y escáneres].

5. Haga clic en [Administrador de dispositivos]. Cuando aparezca la ventana [Control de cuentas de usua-
rio], haga clic en [Sí] (o [Permitir]).

Aparece[Administrador de dispositivos].

6. En el menú [Ver], haga clic en [Mostrar dispositivos ocultos].

7. Busque en la lista [Impresoras] u [Otros dispositivos] y haga doble clic en ellos.

El nombre de su máquina o [Dispositivo desconocido] aparece debajo del elemento seleccionado.
Haga clic en el nombre para seleccionarlo.

8. En el menú [Acción], haga clic en [Desinstalar].

9. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [OK].

10. Cierre [Administrador de dispositivos].

11. Desconecte el cable USB del ordenador y reinicie Windows.

12. Desinstale el controlador de acuerdo con el procedimiento siguiente.

P. 326Desinstalación del controlador (Windows 8.1)

13. Inicie la instalación desde el principio según el procedimiento siguiente.

GS2-24 Installation and Initial Settings Windows Version

La instalación del controlador es imposible
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Reinstale el controlador (Windows 10)

Procedimiento

1. Conecte la máquina al ordenador con el cable USB y encienda la máquina.

2. Si aparece el mensaje de [Nuevo hardware encontrado], haga clic en [Cerrar] para cerrarlo.

Desconecte el cable USB de todas las impresoras excepto de la máquina.

3. Haga clic con el botón derecho del ratón en el botón [Inicio] y, a continuación, en [Administrador de dis-
positivos].

4. En el menú [Ver], haga clic en [Mostrar dispositivos ocultos].

5. Busque en la lista [Impresoras] u [Otros dispositivos] y haga doble clic en ellos.

El nombre de su máquina o [Dispositivo desconocido] aparece debajo del elemento seleccionado.
Haga clic en el nombre para seleccionarlo.

6. En el menú [Acción], haga clic en [Desinstalar el dispositivo].

7. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [Aceptar].

8. Cierre [Administrador de dispositivos].

9. Desconecte el cable USB del ordenador y reinicie Windows.

10. Desinstale el controlador de acuerdo con el procedimiento siguiente.

P. 327Desinstalación del controlador (Windows 10)

11. Inicie la instalación desde el principio según el procedimiento siguiente.

GS2-24 Installation and Initial Settings Windows Version

La instalación del controlador es imposible

324  Problemas de software

https://downloadcenter.rolanddg.com/contents/manuals/GS2-24_INS2-H_WIN_JP/index.html


Reinstale el controlador (Windows 11)

Procedimiento

1. Conecte la máquina al ordenador con el cable USB y encienda la máquina.

2. Si aparece el mensaje de [Nuevo hardware encontrado], haga clic en [Cerrar] para cerrarlo.

Desconecte el cable USB de todas las impresoras excepto de la máquina.

3. Haga clic con el botón derecho del ratón en el botón [Inicio] y, a continuación, en [Administrador de dis-
positivos].

4. En el menú [Ver], haga clic en [Mostrar dispositivos ocultos].

5. Busque en la lista [Impresoras] u [Otros dispositivos] y haga doble clic en ellos.

El nombre de su máquina o [Dispositivo desconocido] aparece debajo del elemento seleccionado.
Haga clic en el nombre para seleccionarlo.

6. En el menú [Acción], haga clic en [Desinstalar el dispositivo].

7. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [Aceptar].

8. Cierre [Administrador de dispositivos].

9. Desconecte el cable USB del ordenador y reinicie Windows.

10. Desinstale el controlador de acuerdo con el procedimiento siguiente.

P. 327Desinstalación del controlador (Windows 10)

11. Inicie la instalación desde el principio según el procedimiento siguiente.
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Para desinstalar el controlador, siga el siguiente procedimiento.

Desinstalación del controlador (Windows 8.1)

Procedimiento

1. Apague la máquina y desconecte el cable de conexión entre el ordenador y la máquina.

2. Inicie Windows.

3. Haga clic en [Escritorio].

4. Apunte a la esquina inferior derecha de la pantalla para mostrar los accesos y, a continuación, haz clic en
[Configuración].

5. Haga clic en [Panel de control]>[Desinstalar un programa].

6. Haga clic con el botón derecho del ratón en el controlador de la máquina que desea eliminar y, a conti-
nuación, haga clic en [Desinstalar].

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

7. Si aparece un mensaje que le pide que confirme la eliminación, haga clic en [Sí].

8. Haga clic en [Iniciar]>[Escritorio].

9. Abra el Explorador y la carpeta especificada como ubicación de instalación del controlador en el momen-
to de la descarga.

10. Haga doble clic en [SETUP64.EXE] (versión de 64 bits) o en [SETUP.EXE] (versión de 32 bits).

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

Se inicia el programa de instalación del controlador.

11. Seleccione [Desinstalar] y, a continuación, haga clic en [Inicio].

12. Si aparece una ventana que le pide que reinicie el ordenador, haga clic en [Sí].

13. Una vez reiniciado el ordenador, abra de nuevo el Panel de control y haga clic en [Ver dispositivos e im-
presoras].

14. Si puede ver el icono de la máquina que desea eliminar, haga clic con el botón derecho del ratón y, a
continuación, haga clic en [Eliminar dispositivo].

Desinstalación del controlador
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Desinstalación del controlador (Windows 10)

Procedimiento

1. Apague la máquina y desconecte el cable de conexión entre el ordenador y la máquina.

2. Inicie sesión en Windows como administrador del ordenador.

3. Haga clic en [Inicio]>[Sistema de Windows]>[Panel de control]>[Desinstalar un programa].

4. Haga doble clic en el controlador de la máquina que se va a eliminar y, a continuación, haga clic en [Sí].

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

5. Si aparece un mensaje que le pide que confirme la eliminación, haga clic en [Sí].

6. Haga clic con el botón derecho del ratón en el botón [Inicio] y, a continuación, en [Explorador].

7. Abra el Explorador y la carpeta especificada como ubicación de instalación del controlador en el momen-
to de la descarga.

8. Haga doble clic en [SETUP64.EXE] (versión de 64 bits) o en [SETUP.EXE] (versión de 32 bits).

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

Se inicia el programa de instalación del controlador.

9. Seleccione [Desinstalar] y, a continuación, haga clic en [Inicio].

10. Si aparece una ventana que le pide que reinicie el ordenador, haga clic en [Sí].

La desinstalación se completará después de que el ordenador se reinicie.

Desinstalación del controlador
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Desinstalación del controlador (Windows 11)

Procedimiento

1. Apague la máquina y desconecte el cable de conexión entre el ordenador y la máquina.

2. Inicie sesión en Windows como administrador del ordenador.

3. Haga clic en [Iniciar]>[Todas las aplicaciones]>[Herramienta Windows].

4. Haga doble clic en [Panel de control].

5. Haga clic en [Desinstalar un programa].

6. Haga doble clic en el controlador de la máquina que se va a eliminar y, a continuación, haga clic en [Sí].

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

7. Si aparece un mensaje que le pide que confirme la eliminación, haga clic en [Sí].

8. Haga clic con el botón derecho del ratón en el botón [Inicio] y, a continuación, en [Explorador].

9. Abra el Explorador y la carpeta especificada como ubicación de instalación del controlador en el momen-
to de la descarga.

10. Haga doble clic en [SETUP64.EXE].

Cuando aparezca la ventana [Control de cuentas de usuario], haga clic en [Sí] (o [Permitir]).

Se inicia el programa de instalación del controlador.

11. Seleccione [Desinstalar] y, a continuación, haga clic en [Inicio].

12. Si aparece una ventana que le pide que reinicie el ordenador, haga clic en [Sí].

La desinstalación se completará después de que el ordenador se reinicie.

Desinstalación del controlador
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Si el controlador no está instalado correctamente, el controlador instalado aparecerá como [No especifi-
cado] en el ordenador. En estos casos, realice el siguiente procedimiento para reinstalar el controlador.

El controlador no se puede instalar correctamente (Windows 8.1)

Procedimiento

1. Inicie sesión en Windows como administrador del ordenador.

2. En la pantalla [Inicio], haga clic en [Escritorio].

3. Mueva el puntero del ratón a la esquina inferior derecha de la ventana del escritorio y, a continuación,
mueva el puntero del ratón ligeramente hacia arriba.

La barra de accesos aparecerá en la parte derecha de la pantalla.

4. Haga clic en [Configuración].

En la parte derecha de la pantalla aparecerá el acceso de [Configuración].

5. Haga clic en [Contorol Panel].

6. Haga clic en [Devices And Printers].

7. Haga clic con el botón derecho del ratón en el controlador de la máquina que se está utilizando, que está
categorizado como [No especificado], y luego haga clic en [Propiedades].

Si la máquina y el ordenador no están conectados, no se mostrará ningún controlador en el aparta-
do [No especificado]. Si no aparece ningún controlador, encienda la máquina y conéctela al orde-
nador.

8. Haga clic en la pestaña [Hardware] y, a continuación, haga doble clic en el nombre del modelo utilizado.

9. Haga clic en [Cambiar configuración] en la pestaña [General] para ocultar el botón [Cambiar configura-
ción].

Si no aparece la opción de [Cambiar configuración] desde el principio, continúe con el siguiente
paso.

10. Haga clic en [Controladores] y, a continuación, en [Eliminar].

11. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [OK].

En este momento, el controlador del modelo utilizado seguirá apareciendo como [No especifica-
do].

12. Desinstale el controlador.

P. 326Desinstalación del controlador (Windows 8.1)

13. Reinstalar el controlador.

GS2-24 Installation and Initial Settings Windows Version
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El controlador no se puede instalar correctamente (Windows 10)

Procedimiento

1. Inicie sesión en Windows como administrador del ordenador.

2. Haga clic en [Start]>[Windows System]>[Contorol Panel].

3. Haga clic en [Devices And Printers].

4. Haga clic con el botón derecho del ratón en el controlador de la máquina que se está utilizando, que está
categorizado como [No especificado], y luego haga clic en [Propiedades].

Si la máquina y el ordenador no están conectados, no se mostrará ningún controlador en el aparta-
do [No especificado]. Si no aparece ningún controlador, encienda la máquina y conéctela al orde-
nador.

5. Haga clic en la pestaña [Hardware] y, a continuación, haga doble clic en el nombre del modelo utilizado.

6. Haga clic en [Cambiar configuración] en la pestaña [General] para ocultar el botón [Cambiar configura-
ción].

Si no aparece la opción de [Cambiar configuración] desde el principio, continúe con el siguiente
paso.

7. Haga clic en la pestaña [Controlador] y en [Desinstalar el dispositivo].

8. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [Aceptar].

En este momento, el controlador del modelo utilizado seguirá apareciendo como [No especifica-
do].

9. Desinstale el controlador.

P. 327Desinstalación del controlador (Windows 10)

10. Reinstalar el controlador.
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El controlador no se puede instalar correctamente (Windows 11)

Procedimiento

1. Inicie sesión en Windows como administrador del ordenador.

2. Haga clic en [Start]>[Todas las aplicaciones]>[Herramienta Windows].

3. Haga doble clic en [Contorol Panel].

4. Haga clic en [Devices And Printers].

5. Haga clic con el botón derecho del ratón en el controlador de la máquina que se está utilizando, que está
categorizado como [No especificado], y luego haga clic en [Propiedades].

Si la máquina y el ordenador no están conectados, no se mostrará ningún controlador en el aparta-
do [No especificado]. Si no aparece ningún controlador, encienda la máquina y conéctela al orde-
nador.

6. Haga clic en la pestaña [Hardware] y, a continuación, haga doble clic en el nombre del modelo utilizado.

7. Haga clic en [Cambiar configuración] en la pestaña [General] para ocultar el botón [Cambiar configura-
ción].

Si no aparece la opción de [Cambiar configuración] desde el principio, continúe con el siguiente
paso.

8. Haga clic en la pestaña [Controlador] y en [Desinstalar el dispositivo].

9. En la ventana [Confirmar la desinstalación del dispositivo], haga clic en [Aceptar].

En este momento, el controlador del modelo utilizado seguirá apareciendo como [No especifica-
do].

10. Desinstale el controlador.

P. 328Desinstalación del controlador (Windows 11)

11. Reinstalar el controlador.
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¿Están los datos guardados en formato AI 8.0 o EPS 8.0?

Al importar datos creados en Illustrator a CutStudio, solo es posible importar archivos Al 8.0 o EPS 8.0. Si
utiliza una versión superior, guarde los archivos como una versión inferior antes de importarlos.

 ENLACES RELACIONADOS 

・  P. 62 Coloque los datos de impresión

No se pueden importar los datos de Illustrator
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¿El ordenador no está configurado para mostrar las carpetas ocultas?

Ubicación de la carpeta de datos de la muestra

El archivo [Sample.bmp] se encuentra en la carpeta de instalación de CutStudio (normalmente situada
en el [Program Files (x86)]>[CutStudio] en la unidad C)

Es posible que los datos de la muestra no se muestren en algunos casos dependiendo de la configuración
del ordenador. Cuando esto ocurra, realice el siguiente ajuste y vuelva a comprobar la ubicación de alma-
cenamiento de datos.

Procedimiento

1. Abra [Explorador].

Haga clic en la carpeta situada en la esquina inferior izquierda del escritorio.

2. Haga clic en la pestaña de [Ver].

3. Seleccione [Elementos ocultos].

No se pueden encontrar los datos de la muestra
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En esta sección se describen los mensajes de error que pueden aparecer en la pantalla del equipo y cómo
tomar medidas para solucionar el problema. Si la acción descrita aquí no corrige el problema o si aparece
un mensaje de error no descrito aquí, póngase en contacto con su distribuidor autorizado de Roland DG
Corporation.

"COMANDO ERR."

Se han enviado datos que la máquina no es capaz de interpretar

Pulse cualquier tecla para borrar el error. Revise los datos enviados desde el ordenador y luego envíe los
datos correctos.

"PARAMETRO ERR."

El número de parámetros difiere del número permitido

Pulse cualquier tecla para borrar el error. Revise los datos enviados desde el ordenador y luego envíe los
datos correctos.

"FUERA DE RANGO"

El valor del parámetro especificado estaba fuera del rango permitido.

Pulse cualquier tecla para borrar el error. Revise los datos enviados desde el ordenador y luego envíe los
datos correctos.

"ERROR ORIGEN"

La máquina está expuesta a la luz solar directa o a una fuerte iluminación interior y no ha podido de-
tectar el origen inmediatamente después de conectar la alimentación.

Desconecte la alimentación y traslade la máquina a un lugar donde no esté expuesta a la luz solar directa
o a una luz intensa. A continuación, conecte la alimentación.

"ERROR REGISTRO"

La forma o el color de las marcas de corte, o el color o el brillo del material no son adecuados para la
máquina. El problema también puede deberse a un fallo mecánico.

La máquina no fue capaz de leer las marcas de corte. Compruebe la forma y el color de las marcas de
corte, así como el color y el brillo del material.

Si se produce el mismo error incluso después de haber revisado la forma y el color de las marcas de corte,
y el color y el brillo del material, póngase en contacto con su distribuidor autorizado de Roland DG Corpo-
ration.

"ERROR REGISTRO""ERROR ALINEAC."

La marca de corte 2 o 3 está inclinada 5 grados o más

Mensajes de error
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: Marca de corte 2

: Marca de corte 3

Pulse cualquier tecla para borrar el error. Recarga el material.

Mensajes de error
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"ERROR REGISTRO""ERROR LARGO"

La marca de corte 3 se desvía 20 mm o más en la dirección de avance del material

: Marcas de corte 3

Pulse cualquier tecla para borrar el error. Recargar el material o cambiar la posición de la marca de corte
3.

"ERROR REGISTRO""ERROR ANCHO"

La marca de corte 2 se desvía 20 mm o más en la dirección del carro de corte.

: Marca de corte 2

Pulse cualquier tecla para borrar el error. Recargar el material o cambiar la posición de la marca de corte
2

"FUERA DE RANGO"

Este mensaje indica que las marcas de corte o el origen están colocados fuera del material.

Pulse cualquier tecla para borrar el error. Compruebe que las posiciones de las marcas de corte o el origen
no se encuentran fuera del material, y vuelva a realizar los ajustes.

"HOJA NO CARGADA"

Se ha intentado poner a punto la máquina sin cargar material. El material se ha retirado cuando la má-
quina estaba lista para realizar el corte. El material se ha deslizado durante el corte.

Pulse cualquier tecla para borrar la configuración y borrar el mensaje de error. Cargue el material correc-
tamente y prepárelo para el corte (condición de preparación).

 ENLACES RELACIONADOS 

・  P. 27 Posición de carga del material

Mensajes de error
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"AJUSTE <MODO SENSOR>"

Los datos de las marcas de corte se enviaron cuando la máquina estaba en modo manual

Pulse cualquier tecla para borrar el error. Cambie la configuración de la máquina al Sensor Mode y vuelva a
enviar los datos.

 ENLACES RELACIONADOS 

・  P. 76 Configure el ajuste para realizar la alineación automática

"AJUSTE MODO HER <MODO HERRAM>"

No se pudieron leer las marcas de corte en el Sensor Mode.

Pulse cualquier tecla para borrar el error. Cambie la configuración de la máquina al Tool Mode y vuelva a
enviar los datos. Al hacerlo, utilice cuatro marcas de corte. Cuando la máquina está en el Tool Mode, no es
posible cortar utilizando 3 marcas de corte.

Si desea utilizar tres marcas de corte, deje la máquina en Sensor Mode y cambie la forma y el color de las
marcas de corte o el color y el brillo del material.

 ENLACES RELACIONADOS 

・  P. 17 Marcas de corte/marcas de herramientas

・  P. 298 No se detectan las marcas de corte

"SATURACION DATOS"

La cantidad de datos almacenados en la máquina es demasiado grande y no se puede ejecutar "REPLO-
TEAR"

Procedimiento

1. Borre los datos almacenados en la máquina.

2. Disminuye el tamaño de los datos enviados desde el ordenador y vuelve a enviarlos.

3. Lleve a cabo "REPLOTEAR".

 ENLACES RELACIONADOS 

・  P. 230 Cortar los mismos datos repetidamente

"POSICION INCORR."

Los rodillos de arrastre están en posiciones en las que el material no puede ser arrastrarse.

Pulse cualquier tecla para borrar la configuración y borrar el mensaje de error. Mueva los rodillos de arras-
tre a las posiciones correctas y vuelva a cargar el material.

Si el mensaje aparece aunque los rodillos de arrastre se muevan a las posiciones correctas, la máquina puede estar ex-
puesta a la luz solar directa o a una iluminación interior intensa. Desconecte la alimentación y traslade la máquina a un
lugar donde no esté expuesta a la luz solar directa o a una iluminación intensa.

NOTA

Mensajes de error
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Después de mover la máquina, conecte la alimentación.

 ENLACES RELACIONADOS 

・  P. 29 Carga de material plano

・  P. 35 Carga de material en rollo

"ERROR MOTOR"

Se colocó una carga pesada en el motor y el funcionamiento se detuvo

Cuando la máquina se sobrecarga en las siguientes condiciones, etc., aparece la página "ERROR MOTOR".

• El corte se realizó con un material grueso cargado

• El material fue arrancado repentinamente de la bobina durante el corte sin ser alimentado de antema-
no

• El material se atascó

Desconecte la alimentación, baje la palanca de carga y vuelva a cargar el material.

Material del rollo de corte

Extraiga del rollo la longitud de material que va a cortar. Además, realice una prueba de avance antes de
cortar.

Al hacerlo, ajuste un valor de unos 20 cm más largo que la longitud de corte en "AREA" en el menú de la
pantalla.

Corte de material grueso

Ajuste el ajuste de calidad en "PESADO".

"ERROR EEPROM "/"SOLENOID ERROR"

Desconecte la alimentación y póngase en contacto con su distribuidor autorizado de Roland DG Corpora-
tion.

Mensajes de error
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La zona de corte lateral del material (dirección en la que se mueve el carro de corte) viene determinada
por las posiciones de los rodillos de arrastre. El área de corte se extiende entre los dos rodillos de arras-
tre, menos aproximadamente 1 mm en cada lado.

Rodillo de arrastre

Área de corte

Origen de las coordenadas de corte

A Máx. 584 mm

B

Tipo de material especificado

• "ROLLO" / "BORDE"
Máx. 25.000 mm *1

• "PIEZA"
Máx.: Longitud detectada *2

C 10 a 25 mm

D Aprox. 1 mm

E 15 mm

F 50 mm o más

 

*1 La precisión está garantizada hasta 1.600 mm.

*2 Si la longitud detectada es de 1.600 mm o más, el material se determina como "ROLLO" y la longitud del área de corte se
ajustará a aproximadamente 25.000 mm. Sin embargo, la pantalla no muestra la longitud.

 

Área de corte
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Ajuste los márgenes y la distancia entre las marcas de corte. Tenga en cuenta el margen necesario para
cortar el material y fije la posición de la marca de corte.

Área de impresión con marcas de corte (al crear datos de corte con CutStudio)

Asegúrese de que la zona en la que se colocan las marcas de corte está libre de cualquier ilustración o suciedad que no
sean las marcas de corte.

NOTA

Longitud (L) entre las marcas de corte

Ancho (W) entre las marcas de corte

Área de impresión

A 500 mm o menos

B 610 mm o menos

C 10 a 60 mm *1

D 10 a 42,5 mm

E 50 mm o más

F 20 mm

 

*1 Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utilice material en
tamaños distintos a A3, A4 o B4.

Los márgenes y la distancia entre las marcas de
corte
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• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al menos 30 mm
(W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia despejada es inferior a 30
mm, la marca de corte no puede leerse.

 

 ENLACES RELACIONADOS 

・  P. 67 Ajuste las condiciones de impresión

Los márgenes y la distancia entre las marcas de corte
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Área de impresión con marcas de corte (al crear datos de corte con Adobe
Illustrator/CorelDRAW)

Asegúrese de que la zona en la que se colocan las marcas de corte está libre de cualquier ilustración o suciedad que no
sean las marcas de corte.

NOTA

Longitud (L) entre las marcas de corte

Ancho (W) entre las marcas de corte

Gama de corte

A 1.500 mm o menos

B Ancho del material

C 10 mm o más *1

D 10 mm o más

E 50 mm o más

F 20 mm

 

*1 Ajuste las posiciones de las marcas de corte manualmente. Tenga en cuenta los siguientes puntos cuando utilice materiales en
tamaños distintos a A3, A4 o B4.

• Cuando utilice un rodillo de arrastre dentro del patrón de presión más a la izquierda, asegúrese de dejar al menos 30 mm
(W) desde el extremo izquierdo del patrón de presión hasta la marca de corte. Si la distancia despejada es inferior a 30
mm, la marca de corte no puede leerse.

Los márgenes y la distancia entre las marcas de corte
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 ENLACES RELACIONADOS 

・  P. 100 Ajuste las condiciones de impresión

・  P. 154 Ajuste las condiciones de impresión

Los márgenes y la distancia entre las marcas de corte
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Sistema de accionamiento Servomotor de control digital

Mecanismo de corte Método de desplazamiento del material

Tamaño del material
aceptable

Anchura de 50 mm a 700 mm

Longitud Material del rollo: sin restricciones
Material plano: 100 mm o más

Superficie máxima de corte 584 mm (ancho) × 25.000 mm (largo)

Herramientas utilizables • Cuchilla de la serie CAMM-1 (ZEC-U5032/U5022/U5025/U3017)
• Cuchilla de cama plana (ZEC-U1715/U3050/U3075/U3100)
• Cuchilla de película para ventanas (ZEC-U5010)

Velocidad de corte 10 a 850 mm/s

Fuerza de la cuchilla 30 a 500 gf

Resolución mecánica 0,0125 mm/paso

Resolución del software 0,025 mm/paso

Precisión de la distancia *1 Error inferior a ±0,2 % de la distancia recorrida o 0,1 mm lo que sea mayor

Repetibilidad*1*2 0,1 mm o menos

Precisión de la alineación para la impresión y el
corte cuando se carga el material impreso*1*3

±1 mm o menos para una distancia de movimiento de 210 mm o menos en la
dirección de avance del material y una distancia de movimiento de 170 mm o
menos en la dirección de la anchura (No tiene en cuenta la influencia de la
impresora y el material)

Conectividad • Ethernet (conmutación automática entre 10BASE-T y 100BASE-TX)
• USB 2.0 (compatible con FULL SPEED)

Memoria de repetición 2 MB (tamaño del buffer: 8 MB)

Sistema de mando CAMM-GLⅢ

Suministro de energía Adaptador de CA específico
Entrada: 100 - 240 Vac, 50/60 Hz
Salida: 24 VCC 2,7 A

Corriente nominal 1,0 A

Consumo de energía Aprox. 24 W

Nivel de ruido acústico Durante la operación 70 dB (A) o menos

Durante el modo de es-
pera

40 dB (A) o menos

Dimensiones exteriores 860 mm (Anchura) × 319 mm (Profundidad) × 235 mm (Altura)

Peso 13,5 kg

Medio ambiente • Temperatura: 5 a 40 °C
• Humedad: 20 a 80 % de HR (sin condensación)

Elementos incluidos Cable de alimentación, adaptador de CA, cuchilla, soporte de cuchilla, base
de rodillo, cable USB, herramienta de alineación, manuales

 

*1 Según el material y las condiciones de corte especificadas por Roland DG Corporation.

*2 • Excluyendo la expansión/contracción del material
• Longitud en la dirección de avance de la hoja: Dentro de 1.600 mm

*3 Según las normas de medición especificadas por Roland DG Corporation.

• Se debe incluir el software de Roland DG Corporation.
• Se presupone el uso de una impresora láser o de inyección de tinta con una resolución de 720 dpi o superior.
• Excluye el material brillante y/o laminado.
• Excluye los efectos de la impresión deformada debido a la precisión de la impresora o los efectos de la expansión/contra-

cción del material.
• Puede no ser leído correctamente por el sensor dependiendo de la tinta de impresión (negra) utilizada.

 

Especificaciones
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Los nombres de las empresas y de los productos son marcas comerciales o marcas comerciales registradas
de sus respectivos titulares.

Nota
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